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Introduction

Introduction

Thank you for purchasing an NA-series Programmable Terminal.

This manual contains information that is necessary to use the NA-series Programmable Terminal.
Please read this manual and make sure you understand the functionality and performance of the
NA-series Programmable Terminal before you attempt to use it in a control system.

Keep this manual in a safe place where it will be available for reference during operation.

Intended Audience

This manual is intended for the following personnel, who must also have knowledge of electrical sys-
tems (an electrical engineer or the equivalent).

» Personnel in charge of introducing FA systems.

» Personnel in charge of designing FA systems.

» Personnel in charge of installing and maintaining FA systems.
» Personnel in charge of managing FA systems and facilities.

Applicable Products

This manual covers the following products.

* NA-series Programmable Terminals ™’

*1. Unless otherwise specified, the descriptions for the NA5-CICOWOO OO apply to the NAS-OOJUOOOO as
well.
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Relevant Manuals

Relevant Manuals

The basic information required to use an NA-series PT is provided in the following three manuals.
* NA-series Programmable Terminal Hardware User’s Manual (Cat. No. V117)

» NA-series Programmable Terminal Software User’s Manual (Cat. No. V118)

» NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)

Operations are performed from the Sysmac Studio Automation Software.

Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for information on the Sys-
mac Studio.

Other manuals are necessary for specific system configurations and applications.

The following manual is also available to walk you through installations and operations up to starting
actual operation using simple examples.

Refer to it as required.
» NA-series Programmable Terminal Startup Guide Manual (Cat. No. V120)
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Manual Structure

Page Structure

and Markings

The following page structure is used in this manual.

Level 2 heading —

Level 3 heading

A step in a procedure —
Indicates a procedure.

Special information —]

Icons indicate precautions,
additional information, or
reference information.

Al A=

- 3-3 Installing NA-series PTs

—— 3-3-1 |Installation in a Control Panel

I Installation in a Control Panel

3 Installation and Wiring

The NA-series PT is installed by embedding it in a control panel. Panel Mounting Brackets and a Phillips screwdriver are
required to mount the NA-series PT. The required number of Panel Mounting Brackets are included with the NA-series PT.

= ©

Panel Mounting Bracket  Phillips screwdriver
Use the following installation procedure.

1 Open a hole in which to embed the NA-series PT with the following dimensions and insert the
NA-series PT from the front side of the panel.
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Manual Structure

—— Level 1 heading

Level 2 heading
~ Level 3 heading

Give the current
headings.

— Page tab
Gives the number
of the main section.
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Recommended panel thickness: 1.6 to 6.0 mm

Model

Dimensions

NAS-15WOO00

392 *10 x 268 *10 mm (horizontal x vertical)

NA5-12WwO000

310 *10 x 221 *10 mm (horizontal x vertical)

NAS-owWOO0O0

261 *10 x 166 *10 mm (horizontal x vertical)

NAS-7WO OO0

197 * 050 x 141 *0-5:0 mm (horizontal x vertical)

S Additional Information

You can use an NS-USBEXT-1M USB Relay Cable to extend the USB slave connector on the
back panel of the NA-series PT to the front surface of a control panel. If you use the USB Relay
Cable, open a hole with the following dimensions and install the Cable.

2 Attach the panel mounting brackets from the back of the panel as shown in the following figure.

The number of mounting brackets depends on the size of the NA-series PT, as shown in the following
table. Refer to Bracket Mounting Locations for Different NA-series PT Sizes on page 3-8, below.

Model Number of Panel Mounting Brackets
NA5-15WO000 8 locations
NA5-12wO000 6 locations
NA5-OWO OO0 4 locations
NA5-7WOO0O0 4 locations

Catch the brackets in the mounting holes in the NA-series PT, pull forward lightly, and then use
a Phillips screwdriver to tighten the screws and secure the NA-series PT to the panel, which will
be held between the mounting brackets and the NA-series PT.

Manual name
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Note This illustration is provided only as a sample. It may not literally appear in this manual.
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Manual Structure

Special Information

Special information in this manual is classified as follows:

Precautions for Safe Use

Precautions on what to do and what not to do to ensure safe usage of the product.

|E| Precautions for Correct Use

Indicates precautions on what to do and what not to do to ensure proper operation and perfor-
mance.

@ Additional Information

Additional information to read as required.

This information is provided to increase understanding or make operation easier.

L~ Version Information

Information on differences in specifications and functionality with different versions is given.
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Sections in this Manual

Sections in this Manual

Introduction to the NA-series
Programmable Terminals

Connecting to HMIs
from External Devices

Basic Sysmac Studio

Operations Other Functions

HMI Configuration

SN\

and Setup Appendices
Creating the HMI ind
Application ex
Objects

Connecting to the HMI

Debugging

Synchronizing Projects

Reusing Objects
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Terms and Conditions Agreement

Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

® Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and workman-
ship for a period of twelve months from the date of sale by Omron (or such other period expressed in
writing by Omron). Omron disclaims all other warranties, express or implied.

® Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, ABOUT
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF
THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE
PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses based
on infringement by the Products or otherwise of any intellectual property right.

® Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form originally
shipped with Buyer responsible for labor charges for removal or replacement thereof) the non-com-
plying Product, (ii) repair the non-complying Product, or (iii) repay or credit Buyer an amount equal
to the purchase price of the non-complying Product; provided that in no event shall Omron be
responsible for warranty, repair, indemnity or any other claims or expenses regarding the Products
unless Omron’s analysis confirms that the Products were properly handled, stored, installed and
maintained and not subject to contamination, abuse, misuse or inappropriate modification. Return of
any Products by Buyer must be approved in writing by Omron before shipment. Omron Companies
shall not be liable for the suitability or unsuitability or the results from the use of Products in combi-
nation with any electrical or electronic components, circuits, system assemblies or any other materi-
als or substances or environments. Any advice, recommendations or information given orally or in
writing, are not to be construed as an amendment or addition to the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL, OR CON-
SEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY
WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED IN CONTRACT,
WARRANTY, NEGLIGENCE OR STRICT LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the Product on
which liability is asserted.
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Terms and Conditions Agreement

Application Considerations

| suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or regulations
which apply to the combination of the Product in the Buyer’s application or use of the Product. At
Buyer’s request, Omron will provide applicable third party certification documents identifying ratings
and limitations of use which apply to the Product. This information by itself is not sufficient for a com-
plete determination of the suitability of the Product in combination with the end product, machine, sys-
tem, or other application or use. Buyer shall be solely responsible for determining appropriateness of
the particular Product with respect to Buyer’s application, product or system. Buyer shall take applica-
tion responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR
PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO
ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable Product, or
any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a guide for
the user in determining suitability and does not constitute a warranty. It may represent the result of
Omron’s test conditions, and the user must correlate it to actual application requirements. Actual perfor-
mance is subject to the Omron’s Warranty and Limitations of Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on improvements and other
reasons. It is our practice to change part numbers when published ratings or features are changed, or
when significant construction changes are made. However, some specifications of the Product may be
changed without any notice. When in doubt, special part numbers may be assigned to fix or establish
key specifications for your application. Please consult with your Omron’s representative at any time to
confirm actual specifications of purchased Product.

I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be accurate; how-
ever, no responsibility is assumed for clerical, typographical or proofreading errors or omissions.
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Safety Precautions

Safety Precautions

Definition of Precautionary Information

The following notation is used in this manual to provide precautions required to ensure safe usage of
the NA-series Programmable Terminal. The safety precautions that are provided are extremely impor-
tant to safety. Always read and heed the information provided in all safety precautions.

The following notation is used.

Indicates a potentially hazardous situation which, if

WAR N I N G not avoided, could result in mild or moderate injury or
at the worst, serious injury or death. Additionally,

there may be severe property damage.

Indicates a potentially hazardous situation which, if not

A C a u t i o n avoided, may result in minor or moderate injury, or

property damage.

Precautions for Safe Use

Indicates precautions on what to do and what not to do to ensure safe usage of the product.

LI Precautions for Correct Use
Indicates precautions on what to do and what not to do to ensure proper operation and performance.

Symbols

The triangle symbol indicates precautions (including warnings).

The circle and slash symbol indicates operations that you must not do.
® The specific operation is shown in the circle and explained in text.
This example indicates prohibiting disassembly.
A The specific operation is shown in the triangle and explained in text.

This example indicates a general precaution.

NA-series Programmable Terminal Software User’s Manual (V118) 13



Safety Precautions

Warnings

/\ WARNING

Do not attempt to take the NA Unit apart and do not touch the product inside while the
power is being supplied. Otherwise it may result in electric shock.

Always ensure that the personnel in charge confirm that installation, inspection, and
maintenance were properly performed for the NA Unit. “Personnel in charge” refers to
individuals qualified and responsible for ensuring safety during machine design,
installation, operation, maintenance, and disposal.

Ensure that installation and post-installation checks are performed by personnel in charge
who possess a thorough understanding of the machinery to be installed.

Do not use the input functions such as the touch panel or function keys of the NA Unit, in
applications that involve human life, in applications that may result in serious injury, or for
emergency stop switches.

Do not attempt to disassemble, repair, or modify the NA Unit. It may cause NA Unit to lose
its safety function.

@ PP

Never press two points or more on the touch panel of the NA Unit at a time. Touching two
points or more interrupts normal touch panel operations.

14 NA-series Programmable Terminal Software User’s Manual (V118)



Precautions for Safe Use

Precautions for Safe Use

* When unpacking the NA Unit, check carefully for any external scratches or other damages. Also,
shake the NA Unit gently and check for any abnormal sound.

* The NA Unit must be installed in a control panel.

» The mounting panel must be between 1.6 and 6.0 mm thick. Tighten the Mounting Brackets evenly to
a torque of between 0.5 and 0.6 N-m to maintain water and dust resistance. If the tightening torque
exceeds the specified value, or the tightening is not even, deformation of the front panel may occur.
What is more, make sure the panel is not dirty or warped and that it is strong enough to hold the NA
Unit.

» Do not let metal particles enter the NA Unit when preparing the panel.
» Turn OFF the power supply before connecting or disconnecting cables.

» Periodically check the installation conditions in applications where the NA Unit is subject to contact
with oil or water.

« Be certain to use the cables with lock mechanism such as serial cable or the Ethernet cable after
confirming if it is securely locked.

» Do not touch the packaging part of the circuit board with your bare hands. Discharge any static elec-
tricity from your body before handling the board.

* Do not use volatile solvents such as benzene and thinners or chemical cloths.

» Water and oil resistance will be lost if the front sheet is torn or is peeling off. Do not use the NA Unit,
if the front sheet is torn or is peeling off.

» As the rubber packing will deteriorate, shrink, or harden depending on the operating environment,
periodical inspection is necessary.

» Confirm the safety of the system before turning ON or OFF the power supply, or pressing the reset
switch.

* The whole system may stop depending on how the power supply is turned ON or OFF. Turn ON/OFF
the power supply according to the specified procedure.

» Operate DIP switch according to the following way.

Correct technique Incorrect technique

- e
DIP switch

The DIP switch may break if it is levered with a tool against the case as shown in the figure.

* Once the DIP switch settings are changed, reset by pressing the reset switch, or restart the power
supply.
+ Initialize the project, after confirming that existing project is backed up at the Sysmac Studio.

* When changing the password, do not reset or turn OFF the power supply until the writing is com-
pleted. A failure to store the password may cause the project to fail to function.

» While uploading or downloading a project or a system program, do not perform the operations as fol-
lows. Such operations may corrupt the project or the system program:

» Turning OFF the power supply of the NA Unit

* Resetting the NA Unit.

» Removing the USB devices or SD card.

» Disconnecting the cable between a support tool and the NA Unit.
» Do not connect an AC power supply to the DC power terminals.
» Do not perform a dielectric strength test.

Back of the case
N\
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Precautions for Safe Use

Use a DC power with a slight voltage fluctuation and that will provide a stable output even if the input
is momentarily interrupted for 10 ms. Also use the one with reinforced insulation or double insulation.

Rated Power Supply Voltage: 24VDC (Allowable range 19.2 to 28.8VDC)

Use a power cable with AWG#12 to #22 thick (0.35mm2 to 3.31mm2). Peel the coating 7mm length
and tighten the terminal screw with the torque in the range of 0.5 to 0.6 N-m. Also confirm if the termi-
nal screw is tighten appropriately.

To prevent malfunctions caused by noise, ground the NA Unit correctly.

Do not use any battery if strong impact is applied to it (e.g. by dropping on the floor) because such a
battery may cause a leakage.

Confirm the type of the battery to install the battery properly.

Apply power for at least five minutes before changing the battery. Mount a new battery within five
minutes after turning OFF the power supply. If power is not supplied for at least five minutes, the
clock data may be lost. Check the clock data after changing the battery.

Do not dismantle a battery nor let it short-circuit.

Do not apply an impact with the lithium battery, charge it, dispose it into a fire, or heat it. Doing either
of them may cause an ignition or a bursting.

Dispose of the NA Units and batteries according to local ordinances as they apply.

{m |
B AEK

The following precaution must be displayed on all products containing lithium primary batteries with a
perchlorate content of 6ppb or higher when exporting them to or shipping them through California,
USA.

Perchlorate Material - special handling may apply.
See www.dtsc.ca.gov/hazardouswaste/perchlorate

The NA-Series contains a lithium primary battery with a perchlorate content of 6ppb or higher. When
exporting a product containing the NA-Series to or shipping such a product through California, USA,
label all packing and shipping containers appropriately.

Do not connect the USB devices in the environment subject to the strong vibration.
Do not connect USB devices which are not allowed to connect to NA Unit.

Start actual system application only after checking normal operation of the system including storage
devices such as USB memory and SD card.

When connecting peripheral devices which do not meet the performance level of the NA Unit for
noise and static electricity, ensure sufficient countermeasures against noise and static electricity dur-
ing installation of the peripheral devices to the NA Unit.

Do not carry out the following operations when accessing USB devices or SD card:
» Turning OFF the power supply of the NA Unit
» Press the Reset switch of the NA Unit
 Pull out the USB devices or SD card

When using the No. 6 pin of the serial port connector for a voltage of DC+5V, make sure the supply
equipment's current capacity is below 250mA before using it. The DC+5V voltage output of the NA
Unit is +5V+5%, and the maximum current is 250mA.

To ensure the system's safety, make sure to incorporate a program that call periodically signals dur-
ing the operation at connected device side and can confirm the normal functionality of the NA Unit
before running the system.

Start actual system application only after sufficiently checking project, subroutine and the operation of
the program at the connected device side.

To execute a subroutine with multiple threads, fully check the operation of the program that takes
multithreads into consideration, before starting actual system application.

To use numeric input functions safely, always make maximum and minimum limit settings.
Do not press the touch panel with a force greater than 30 N.
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» Do not use hard or pointed objects to operate or scrub the screen, otherwise the surface of the
screen may be damaged.

» The deterioration over time may cause the touch points to move on the touch panel. Calibrate the
touch panel periodically.

+ A touch position detection error of approximately 20 pixels may occur due to the precision of the
touch panel. Always take this into account when positioning objects on the panel so adjoining objects
will not be activated by mistake.

» Confirm the safety of the system before pressing the touch panel.

» Do not accidentally press the touch panel when the backlight is not lit or when the display does not
appear or is too dark to identify visually.

* You can change the brightness by changing the setting such as in the system menu or by download-
ing project.
If the brightness is set to very dark, it causes flickering or unreadable screen. Additionally, the bright-
ness can be restored by transferring the project again after setting the property of the brightness
appropriately.
In a case of the applications where end users can control the brightness, create the applications so
as keeping on operations by such as assigning the function which restores the brightness to one of
function keys, if necessary.

+ Signals from the touch panel may not be entered if the touch panel is pressed consecutively at high
speed. Make sure to go on the next operation after confirming that the NA Unit has detected the input
of the touch panel.

» The function keys have the restrictions as follows:

» Using both anti-reflection sheet and protective cover interrupts the normal function key operation.
Do not use them together.

* When you use gloves or others, the function keys may not work correctly depending on the mate-
rial and thickness of the gloves. Take actual conditions of the gloves usage into considerations
prior to the system startup to perform the confirmation.

+ The function keys do not work when covered with water. Remove the water completely before
use.
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Precautions for Correct Use

18

® Do not install or store the NA Unit in any of the following locations:

Locations subject to severe changes in temperature

Locations subject to temperatures or humidity outside the range specified in the specifications
Locations subject to condensation as the result of high humidity

Locations subject to corrosive or flammable gases

Locations subject to strong shock or vibration

Locations outdoors subject to direct wind and rain

Locations subject to strong ultraviolet light

Locations subject to dust

Locations subject to direct sunlight

Locations subject to splashing oil or chemicals

® Take appropriate and sufficient countermeasures when installing systems in
the following locations:

Locations subject to static electricity or other forms of noise
Locations subject to strong electric field or magnetic field
Locations close to power supply lines

Locations subject to possible exposure to radioactivity
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Regulations and Standards

Conformance to EC Directives

I Applicable Directives

* EMC Directive

I Concepts

® EMC Directive

OMRON devices that comply with EC Directives also conform to the related EMC standards so that
they can be more easily built into other devices or the overall machine. The actual products have
been checked for conformity to EMC standards.*

Whether the products conform to the standards in the system used by the customer, however, must
be checked by the customer. EMC-related performance of the OMRON devices that comply with EC
Directives will vary depending on the configuration, wiring, and other conditions of the equipment or
control panel on which the OMRON devices are installed. The customer must, therefore, perform
the final check to confirm that devices and the overall machine conform to EMC standards.

*

Applicable EMC (Electromagnetic Compatibility) standards are as follows:
EMS (Electromagnetic Susceptibility): EN 61131-2:2007
EMI (Electromagnetic Interference): EN 61131-2:2007

® Conformance to EC Directives

The NA-series PTs comply with EC Directives. To ensure that the machine or device in which the
NA-series PT is used complies with EC Directives, the NA-series PT must be installed as follows:

» The NA Unit must be installed within a control panel.
* You must use reinforced insulation or double insulation for the DC power supplies connected to
the NA Unit.

» NA-series PTs that comply with EC Directives also conform to the Common Emission Standard
(EN 61000-6-4). Radiated emission characteristics (10-m regulations) may vary depending on the
configuration of the control panel used, other devices connected to the control panel, wiring, and
other conditions.

You must therefore confirm that the overall machine or equipment complies with EC Directives.

» This is a Class A product (for industrial environments). In a residential environment, it may cause
radio interference, in which case the user may be required to take appropriate measures.
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Regulations and Standards

Conformance to KC Standards

Observe the following precaution if you use NA-series PTs in Korea.

Class A Device (Broadcasting Communications Device for Business Use)

This device obtained EMC registration for office use (Class A), and it is intended to be used in places
other than homes. Sellers and/or users need to take note of this.
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Related Manuals

Related Manuals

The following manuals are related to the NA-series PTs. Use these manuals for reference.

Manual name Cat. No. Models Applications Description
NA-series Program- | V117 NAS-OWOOOd Learning the speci- | Information is provided on NA-series
mable Terminal Hard- fications and set- PT specifications, part names, instal-
ware User’s Manual tings required to lation procedures, and procedures to
install an NA-series | connect an NA Unit to peripheral
PT and connect devices.
peripheral devices. | |nformation is also provided on main-
tenance after operation and trouble-
shooting.
NA-series Program- | V118 NAS-COwOOOd Learning about NA-series PT pages and object func-
mable Terminal Soft- NA-series PT tions are described.
ware User’s Manual pages and object
functions.
NA-series Program- | V119 NAS-OOwOOOd Learning the speci- | Information is provided on connec-
mable Terminal fications required tion procedures and setting proce-
Device Connection to connect devices | dures to connect an NA-series PT to
User’s Manual to an NA-series a Controller or other device.
PT.
NA-series Program- | V120 NAS-COwOOOd Learning in con- The part names and installation pro-
mable Terminal crete terms infor- | cedures are described followed by
Startup Guide mation required to | page creation and transfer proce-
install and start the | dures with the Sysmac Studio. Also
operation of an operation, maintenance, and inspec-
NA-series PT. tion procedures after the project is
transferred are described. Sample
screen captures are provided as
examples.
NX-series CPU Unit | W535 NX701-0J000 Learning the basic | An introduction to the entire

Hardware User's
Manual

specifications of
the NX-series CPU
Units, including
introductory infor-
mation, designing,
installation, and
maintenance.
Mainly hardware
information is pro-
vided.

NX-series system is provided along
with the following information on the
CPU Unit.

» Features and system configuration
* Introduction

+ Part names and functions

» General specifications

* Installation and wiring

* Maintenance and inspection

Use this manual together with the
NJ/NX-series CPU Unit Software
User's Manual (Cat. No.W501).

NA-series Programmable Terminal Software User’s Manual (V118)

21



Related Manuals

Manual name Cat. No. Models Applications Description
NJ-series CPU Unit | W500 NJ501-00000 Learning the basic | An introduction to the entire
Hardware User’s NJ301-000000 specifications of NJ-series system is provided along
Manual the NJ-series CPU | with the following information on a
NJ101-0000 Units, including Controller built with a CPU Unit.
introductory infor- | . Features and system configuration
_matlon,_deS|gn|ng, * Introduction
installation, and .
maintenance. » Part names and functions
Mainly hardware » General specifications
information is pro- | Installation and wiring
vided. * Inspection and maintenance
Use this manual together with the
NJ-series CPU Unit Software User’s
Manual (Cat. No. W501).
NJ/NX-series CPU W501 NX701-00000 Learning how to Provides the following information on
Unit Software User’s NJ501-00000 program and set a Controller built with an
Manual NJ301-0000 up an . NJ/NX-series CPU Unit.
NJ/NX-series CPU | . cpU Unit operation
NJ101-0000 Unit. )
* CPU Unit features
Mainly software | . |pjtia| settings
U:;c;r:atlon ISpro- 1, Programming based on IEC
61131-3 language specifications
Use this manual together with the
NJ/NX-series CPU Unit Hardware
User’s Manual (NJ Series: W500,
NX Series: W535).
CJ Series Program- | W393 CJ1H-CPUOOH-R Learning the basic | The following information is provided
mable Controllers CJ1G/H-CPULICIH specifications of on a CJ-series PLC.
Operation Manual CJ1G-CPUCICIP the CJ-series « Introduction and features
PLCs, including » System configuration design
CJ1M-CPULIO] introductory infor- . .
CJ1G-CPUOO mation, designing, * Installation and wiring
installation, and * 1/0 memory allocation
maintenance. » Troubleshooting
Use this manual together with the
Programming Manual (Cat. No.
W394).
CS/CJINSJ Series W394 CS1G/H-CPUOOH Learning about the | The following information is provided

Programmable Con-
trollers Operation
Manual

CS1G/H-CPUCIO-V1
CS1D-CPULIOH
CS1D-CPUCIOS
CJ1H-CPULOH-R
CJ1G/H-CPUOOH
CJ1G-CPULICIP
CJ1M-CPUOIT]
CJ1G-CPUOO
NSJO-0000(B)-G5D
NSJO-O000(B)-M3D

functions of the
CS/CJ-series and
NSJ-series PLCs.

on a CS/CJ-series or NSJ-series
PLC.

* Programming

» Master function

* File memory

+ Other functions

Use this manual together with the

Operation Manual (CS-series PLCs:
W339, CJ-series PLCs: W393).
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Related Manuals

Manual name Cat. No. Models Applications Description
CS/CJ/NSJ-series W340 CS1o-CPU-UOO-0O0 Learning detailed | Instructions are described in detail.
Instructions Refer- CJ1o-CPU-O00O-000 informa.tion_ On pro- | when programming, use this manual
ence Manual CJ2H-CPU-000-000 ggir:m'”g instruc- | together with the Operation Manual

: (CS-series PLCs: W339, CJ-series
NSJBH-00000-000 PLCs: W393) and the Programming
Manual (W394).
CS/CJ Series Pro- W341 CQM1H-PROO01 Learning the oper- | The operating procedures of the Pro-
gramming Consoles CQM1-PRO01 ating procedures gramming Consoles are described.
Operation Manual C200H-PRO27 :i:jqegorr?g(;?ems- When programming, use this manual
: together with the Operation Manual
+CS1W-KS001 (CS-series PLCs: W339, CJ-series
PLCs: W393), the Programming
Manual (W394), and the Instructions
Reference Manual (W340).
CS/CJ/NSJ Series W342 CS1G/H-CPUOIOH Learning detailed | 1) C-mode commands and 2) FINS
Communications CS1G/H-CPUCIO-V1 specifications on | commands are described in detail.
Commands Refer- CS1D-CPULCIOH the communica- | Refer to this manual for information
ence Manual tions instructions | 54 communications commands
CS1D-CPULILIS addressed to (C-mode commands and FINS com-
CS1w-scuti-v1 CS/CJ-series CPU | mands) addressed to CPU Units.
CS1W-SCBOO-V1 Units and Note Thi | descrb
NSJ-series PLCs. ote This manual describes com-
CJ1G/H-CPULILH munications commands that
CcJ1G-CcpPUOIOP are addressed to a CPU Unit.
CJ1M-CPUOO The communications path is
CJ1G-CPUCIO not. relevant. (The communi-
cations commands can be
CJiw-scutii-vi sent through the serial com-
munications port of the CPU
Unit, the communications
port of a Serial Communica-
tions Board/Unit, or a com-
munications port on another
Communications Unit.)
CJ-series CJ2 CPU | W472 CJ2H-CPU6B-EIP Learning the hard- | The following information is provided
Unit Hardware User’s CJ2H-CPU6LT ware specifica- on a CJ2 CPU Unit.
Manual CJ2M-CPULIC] tliJor?tS of CJ2CPU | . |ntroduction and features
nis. + Basic system configuration
« Part names and functions
« Installation and setting procedures
» Troubleshooting
Use this manual together with the
Software User’s Manual (Cat. No.
W473).
CJ-series CJ2 CPU | W473 CJ2H-CPUGLI-EIP Learning the soft- | The following information is provided

Unit Software User’s
Manual

CJ2H-CPUGO
CJ2Mm-cPuOO

ware specifica-
tions of CJ2 CPU
Units.

on a CJ2 CPU Unit.

» CPU Unit operation

* Internal memory

* Programming

+ Settings

* Functions built into the CPU Unit
Use this manual together with the

Hardware User’s Manual (Cat. No.
W472).
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Related Manuals

Manual name Cat. No. Models Applications Description
Ethernet Units Oper- | W420 CS1W-ETN21 Learning how to Information is provided on the Ether-
ation Manual Con- CJ1W-ETN21 use an Ethernet net Units.
struction of Networks Unit. Information is provided on the basic
setup and FINS communications.
Refer to the Communications Com-
mands Reference Manual (Cat. No.
W342) for details on FINS com-
mands that can be sent to
CS/CJ-series CPU Units when using
the FINS communications service.
Ethernet Units Oper- | W421 CS1W-ETN21 Learning how to Information is provided on construct-
ation Manual Con- CJ1W-ETN21 use an Ethernet ing host applications, including func-
struction of Unit. tions for sending/receiving mail,
Applications socket service, automatic clock
adjustment, FTP server functions,
and FINS communications.
CS/CJ-series Ether- | W465 CJ2H-CPU6B-EIP Learning how to Information is provided on the built-in
Net/IP™ Units Oper- CJ2M-CPU3] use the built-in EtherNet/IP port and EtherNet/IP
ation Manual CSTW-EIP21 EtherNet/IP port of | Units.
CITW-EIP21 the CJ2 CPU Basic settings, tag data links, FINS
Units. communications, and other functions
are described.
Sysmac Studio Ver- W504 SYSMAC-SE20111 Learning about the | The operating procedures of the
sion 1 Operation operating proce- Sysmac Studio are described.
Manual dures and func-
tions of the
Sysmac Studio.
CX-Programmer W446 CXONE-ALOOC-v4 Learning about the | The operating procedures of the

Operation Manual

CXONE-ALOOD-V4

CX-Programmer
except for informa-
tion on function
blocks, ST pro-
gramming, and
SFC programming.

CX-Programmer are described.
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Terminology

Term Description
HMI A general term for interface devices that indicates both hardware and software elements. In
this manual, “HMI” refers to an OMRON Sysmac-brand product unless otherwise specified.
PT The hardware elements of the HMI.
NA Series The NA Series of Programmable Terminals and peripheral devices.
HMI Project A Sysmac Studio project for an HMI.
NA Unit An NA-series Programmable Terminal.
Download Transferring data from the Sysmac Studio to an HMI.
Upload Transferring the project from an HMI to the Sysmac Studio.

IAG collection

When you provide IAGs, you provide them as IAG collections. IAGs are also imported as
IAG collections. An IAG collection contains one or more IAGs.
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Revision History

26

A manual revision code appears as a suffix to the catalog number on the front and back covers of the

manual.

Cat. No. | V118-E1-04 |

*— Revision code

Revision code Date Revised content
01 June 2014 Original production
02 October 2014 | Made revisions accompanying version upgrade.
03 April 2015 Made revisions accompanying version upgrade.
04

October 2015 | Made revisions accompanying version upgrade.
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Introduction to the NA-series Pro-

grammable Terminals
]

This section describes the features, basic system configuration, specifications, and
overall operating procedure of the NA-series Programmable Terminals.
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1-1-1  Features .. ... 1-2
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1-2-1  HMI Software Configuration . ........ ... ... .. .. ... .. . . ... . . . . ... 1-4
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1-2-3  PageS ..o e 1-4
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1-2-5  Memory Specifications for Connected Devices . ....................... 1-6
1-2-6  EVeNts ... 1-7
1-2-7  Subroutines . ... ... 1-8
1-2-8  Functions Shared by the Entire HMI Project . . ... ...... ... ... ... ... .... 1-9
1-2-9  Data That Retained When Power Is Turned OFF ... .................... 1-9
1-3 Operating ProcedureforHMIs ........... ... ... .. ... . iiiuonn. 110
1-3-1  Overall Procedure . . ... ... 1-10
1-3-2  Procedure Details .. ... ... .. .. 1-11
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Introduction to the NA-series Programmable Terminals

NA-series Programmable Terminals

1-1-1

The NA-series Programmable Terminals represent the next generation of HMIs for industrial applica-
tions. They display information on FA manufacturing sites and function as control interfaces while pro-
viding safety, reliability, and maintainability. They provide all of the functions of traditional programmable
terminals with a clearer, easy-to-use interface.

OMRON offers the new Sysmac Series of control devices designed with unified communications speci-
fications and user interface specifications.

The NA-series Programmable Terminals are Sysmac devices that you can use together with the
NJ-series Machine Automation Controllers and the Sysmac Studio Automation Software to achieve
optimum functionality and ease of operation.

If you connect an NA-series Programmable Terminal to an NJ/NX-series Controller, all you have to do
to specify memory in the Controller is to specify the Controller variables for the objects on the Program-
mable Terminal screens. This allows you to create screens without being concerned with the memory
map of the Controller.

Automation Software NA-series PT
Specifications with Only
Variables from Objects on
Screens

Sysmac Studio

Programming with
Variables to Eliminate
Worrying about the
Memory Map

NJ/NX-series Controller

Ethernet

SvSTnac

always in control

Features

I Hardware Features

® High-resolution Display Panels

High-resolution display panels are used to more clearly display large amounts of information than
was possible with previous OMRON products.

® Two Ethernet Ports (Standard Feature)

You can use both Ethernet ports to separate the segment attached to control devices from the seg-
ment attached to maintenance devices. Access is possible from both segments at the same time.

You can connect the following devices.
* NJ/NX-series Controllers

* PLCs

» Computers

» Sysmac Studio
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4
>
® Standard-feature SD Memory Card Slot 8
You can use an SD Memory Card inserted in the NA Unit to automatically transfer the project you %
created on the Sysmac Studio to the NA Unit, to update the system program in the NA Unit, or to é
save the log data from the NA Unit. a0
=)
N-2
» o
I Software Features
® Specifications with Variables for Superior Reusability

If you connect to an NJ/NX-series Controller, all you have to do to specify memory in the Controller
is to specify the Controller variables. This allows you to create objects that are not dependent on N
specific devices or memory maps. This in turn makes the objects much more reusable than they N
were with previous PTs. py
QO

® Program with Visual Basic

You can use Microsoft’s Visual Basic to program advanced functions that you cannot achieve with
standard objects.

® A Wealth of Security Features

The many security features of the NA-series PTs include operation authority settings and execution
restrictions with IDs.

® Use the Integrated Development Environment of Sysmac Studio Automation
Software

You use the Sysmac Studio to create applications for the NA-series Programmable Terminals.

The Sysmac Studio provides an integrated development environment that covers not only the
NA-series Programmable Terminal, but also the Controller and devices on EtherCAT as well.

You can use consistent procedures for all devices regardless of differences in the devices. The Sys-
mac Studio supports all phases of Controller application, from page creation and sequence design
through debugging, simulations, commissioning, and changes during operation.

® A Wealth of Simulation Features

You can perform simulations using a virtual HMI on the Sysmac Studio. And you can also perform
online debugging with a virtual NJ/NX-series Controller.

NA-series Programmable Terminal Software User’s Manual (V118) 1-3
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1-2 How HMis Operate

This section describes how the HMI operates.

1-2-1

An HMI consists of the following software.
» System Program

HMI Software Configuration

The system program is required to start the HMI and execute the runtime. For details, refer to
NA-series Programmable Terminal Hardware User’s Manual (V117).

Runtime

The runtime is the middleware that executes the project. The runtime is started by the system pro-
gram and it manages execution of the project.

Project

You use the Sysmac Studio to create your applications. The applications are executed on the run-

time.

1-2-2 HMI Projects

An HMI project contains mainly the followin

P
O

— Pages

Project ——— Global variables

— Global events E

—— Subroutines

g data.

— You can specify variables,
and the actions for events.

ages consist of
bjects.

HMI variables

vents that are shared

by the entire project

You can start subroutines

when events occur.

In addition, there is data that is shared by the entire project, such as user alarms, data logging, recipes,

and resources.

1-2-3 Pages

One HMI screen is called a page.
There are the following two types of pages.

Page type

Size

Main

Maximum screen size for each model

Page ~|:

You paste objects on the pages.

Popup

Smaller than the maximum screen
size for each model

NA-series Programmable Terminal Software User’s Manual (V118)
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0
1-2-4 Objects g
I
The objects that you paste on HMI pages consist of the following three elements. §
(o]
T
)
Element %
— Properties @~ ----- These are static properties.
Example: Names and other general properties, colors,
positioning, and other display properties, and
Object assigned condition expressions or variables
D —r——Animations @~ ----- Operating properties for condition expressions ;;
Example: Operating specifications, such as flashing, g
enabling/disabling operation, size/coordinate =2
changes, and displaying/hiding. &
— Eventsand =~ """ You can specify events and the actions to perform when the
Actions events occur.

Example: You can specify subroutines to execute, e.g.,
when a function key is pressed or a value
changes.
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1-2-5 Memory Specifications for Connected Devices

I Overview

You use HMI global variables to specify memory in a Controller or PLC.
You assign HMI global variables to connected device variables in advance to map them.

1) Variables for connected devices are registered to device variables in the HMI project with one of the
following methods.

a) Variables for connected devices that are registered in the same project are registered automati-
cally.

b) You can copy and paste variables from another project using the clipboard.
¢) You can import variables from the external connected device.

2) Devices variables are assigned to HMI global variables.
3) The assigned HMI global variables are specified in the properties of the objects.
4) Then, you transfer the project that you created to the HMI.

Sysmac Studio
project

Sysmac Studio Device registered in the project HMI project
(NJ/NX-series Controller)

| HMI settings |
Global variables
,1| Global variables |3) Variables
a) Automatic registration - . specified in
g 3 Pages N properties
1 I
v "éxA e Object J
. ssigned. /
1) | Device variables |~ ) ¢ @
b) Pasted from 4) Transferred.
clipboard. )
c) Importing HMI
Different project, i.e., . .
in Sysmac Studio Physical NJ/NX-series
Controller or other device
Controller /
Global variables P
o O O

Refer to 4-1 Registering Variables on page 4-3 for the details on HMI variables.
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1-2-6 Events

Events are triggers that activate actions.”!

*1. Actions are various operations that can be directly assigned to events.

ajesadQ S|IINH MOH Z-1

Events occur when the common page status or object status meets certain conditions.

Events are classified into three groups as shown below.

Group Description

Global events Events that occur for shared project status. N
[\
&
Events Page and object events Events that occur for specific page or object status. m
S
]

User alarm events Events that occur for user alarm status.
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1-2-7 Subroutines

Introduction to the NA-series Programmable Terminals

You can execute user-created subroutines in the HMI based on the following three types of conditions.

* When global events occur
* When events occur on pages or for objects
* When user alarm events occur

There are two types of subroutines that you can create.

« Global Subroutines

You create these subroutines under the global subroutine item of the HMI project.

» Page Subroutines

You create these subroutines with the page code editor.

You can use Visual Basic to write both the global subroutines and the page subroutines.

Sysmac Studio project

[0]: Event: F1 Key Click

[1]: Event: Interval
Action: IncreaseVariable

Events

* Object event -

* Global events (i.e., events shared by all pages)

Action: CallSubroutine ——r--

Action: CallSubroutine

Called.

v Global
subroutine

N

Coded in Visual Basic

/

-
-

- Page_
subroutine

7Y
1
1
1
T
:
1
1
D Object

» User Alarm Event

[0]: Event: Raised

[1]: Event: Acknowledged
Action: IncreaseVariable

Action: CallSubroutine ————-

* You can call a global subroutine by executing the CallSubroutine action when a global event occurs.
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* You can call a global subroutine or page subroutine by executing the CallSubroutine action when an
event occurs on the page or for an object.

* You can call a global subroutine by executing the CallSubroutine action when a user alarm event
occurs.

ajesadQ S|IINH MOH Z-1

You can also call a global subroutine from another global subroutine or a page subroutine.

1-2-8 Functions Shared by the Entire HMI Project

In addition to global events, the following functions are shared by the entire HMI project.

I Alarms

Alarms notify the user when certain conditions are met in the HMI.

The following alarms are supported.
» User alarms

I Data Logging

You can log data to store the changes in the values of specified variables over time.

100lo1d IINH 24puT 8u} Ag paleys suonouny g-z-1

You can display the saved data with Trend Graph objects. You can also save this data to external files.

I Recipes

A recipe is used to write data (numeric data or text strings) that was set in advance in the project to all
of the specified variables as a group or to read all of the specified variables as a group.

You can manipulate the registered recipe data with Recipe Viewer objects.

I Resources

You can manage resources, such as the text strings, movies, still images, and documents that are dis-
played for objects and alarms on pages.

1-2-9 Data That Retained When Power Is Turned OFF

The following data is retained when the power supply is turned OFF.

With No Battery or Low Battery Voltage

* Project data

Log data that is not written to the SD Memory Card
* User alarm history

Values of variables with Retain attribute
Calibration information for touch panel

With Good Battery (in addition to the above)
» Clock information

NA-series Programmable Terminal Software User’s Manual (V118) 1-9
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1-3 Operating Procedure for HMIs

This section gives the operating procedure for an HMI and then describes it in more detail.

1-3-1

Overall Procedure

The overall procedure to use an HMI is given below.

STEP1

STEP2

STEP3

STEP4

System Configuration and Project Design
Design the system configurations and project.

STEP 1-1 Designing the System Configurations

STEP 1-2 Designing the Project (Pages, Variables, Subroutines, etc.)

Software Settings (Configurations and Setup) and Creating the HMI Application

Create the system configurations that you designed in step 1 on the Sysmac Studio. Also create
the project (pages, variables, subroutines, etc.), build the project, and debug it with simulation

and other functions.

Determining the Connected Device Variables
and Mapping HMI Variables to Them (We rec-
ommend this as the basic procedure.)

Setting HMI Variables First and Then Mapping
Them to Connected Device Variables

STEP 2-1 Starting the Sysmac Studio and Creating
a Project

STEP 2-1 Starting the Sysmac Studio and Creating
a Project

STEP 2-2 Software Settings (Configurations and
Setup)

STEP 2-2 Creating the HMI Application

STEP 2-3 Creating the HMI Application

STEP 2-3 Software Settings (Configurations and
Setup)

STEP 2-4 Building the HMI

STEP 2-4 Building the HMI

STEP 2-5 Offline Debugging

STEP 2-5 Offline Debugging

Mounting and Wiring
Mount the HMI.

Connect the connected device and computer (Sysmac Studio) to the HMI.

Confirming Operation and Starting Actual System Operation

Download the project from the Sysmac Studio.

Make the settings on the System Menu, check operation on the physical devices, and start

operation.
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1-3-2 Procedure Details

STEP1

System Configuration and Project Design

Reference

10} ainpadsold Bunesedo ¢-1

Step Description T

T » Connect an HMI to the external Section 2 Configuration Units in NA Series %
T device. Programmable Terminal Hardware User’s

Designing the « Connect an HMI to the Sysmac | Manual (V117)

System Configu- , ) ) )

rations Studio. NA-series Programmable Terminal Device

Connection User’s Manual (V119)

STEP 1-2 Design the project as given below. | NA Series Programmable Terminal Software

Designing the User's Manual (V118)

Project (Pages,

Variables, Sub-
routines, Etc.)

» Design the contents to display on
the pages (the pages and objects
to use).

Design the execution methods
and contents of the subroutines.

s|ieje ainpeoold Z-¢-1

1) Designing the
Pages and Sub-
routines .

2) Designing + Design the global events.
Items Shared by | - Design the alarms, recipes, data
All Pages logging, and other functions.

* HMI external variable design:

Design the mappings between the

connected device variables and

the HMI global variables.

Design the HMI internal variables

and subroutine variables.

+ Define the attributes of the above
variables, such as the Data Type,
Name, and Retain attributes.

3) Variable Design | *

STEP2

Software Settings (Configurations and Setup) and Creating the HMI Application

Sysmac Studio oper-

Step Description : Reference

ations
STEP 2-1 1. Start the Sysmac Press the New Project | Sysmac Studio Version 1 Opera-
Starting the Sys- | Studio and create a Button. tion Manual (W504)

mac Studio and

Creating a Project

project.
2. Insert the HMI.

Use HMI on the Insert
Menu.

Section 2 Basic Sysmac Studio
Operations
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® Determining the Connected Device Variables and Mapping HMI Variables to

Them

We recommend this procedure as the basic procedure.

» Connecting to a Connected Device Registered in the Current Project

STEP 2-2
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings
on the Sysmac Studio.

Use Configurations and
Setup in the Multiview
Explorer of the Sysmac
Studio.

Section 3 HMI Con-
figuration and Setup

* Mapping Vari-
ables

+ Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables under
Configurations and
Setup — Variable Map-

ping.

3-3 Mapping Vari-
ables on page 3-7

* HMI Settings

+ Set the parameters related to
the HMIL.
Startup Page, Brightness Set-
tings, IP Address, FTP Settings,
NTP Settings, FINS Settings,
VNC Settings, etc.

Make the settings under
Configurations and
Setup — HMI Settings.

3-4 HMI Settings on
page 3-10

* Security Set-
tings and Lan-
guage Settings

» Set the operation rights to the
HMI and the language to display
on the HMI.

Make the settings under
Configurations and
Setup — Security Set-
tings and Configura-
tions and Setup —

Language Settings.

3-5 Security Settings
on page 3-18

3-7 Language Set-
tings on page 3-20

» Connecting to a Connected Device Not Registered in the Current Project

STEP 2-2
Software Set-
tings (Configu-
rations and
Setup)

Make the initial software settings on
the Sysmac Studio.

Use Configurations and
Setup in the Multiview
Explorer of the Sysmac
Studio.

Section 3 HMI Con-
figuration and
Setup

* Register the external connected
devices.

Add the connected
device under Configura-
tions and Setup —
Device References.

3-2 Device Refer-
ences on page 3-3

¢ Device Set-
tings

* You can do either of the following.

a) Importing Variables from the
Actual Connected Device: Place
the Sysmac Studio online with
the connected device and import
the variables from the connected
device.

b) Importing Variables from Another
Project: Copy the variable table
in the other project and paste it
in the variable table for the con-
nected device to import the vari-
ables.

c) Importing Variables from a File:
Import the information on the
variables of the connected
device from a file, such as an
Excel file.

Set up communications
and import the variables.

Copy the variable table
from another project
using the clipboard.

Import variable informa-
tion from a file.
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Assign global variables to connected
device variables (mapping variables).

Map the variables under

Configurations and

Section 3 HMI Con-
figuration and

: Ma;.)pmg Setup — Variable Map- Setup and 3-3 Map-
Variables . ) )
ping. ping Variables on
page 3-7
+ Set the parameters related to the Make the settings under | 3-4 HMI Settings on
HMI. Configurations and page 3-10

* HMI Settings

Startup Page, Brightness Settings,
IP Address, FTP Settings, NTP
Settings, FINS Settings, VNC Set-
tings, etc.

Setup — HMI Settings.

¢ Security Set-

Set the operation rights to the HMI
and the language to display on the

Make the settings under

Configurations and

3-5 Security Set-
tings on page 3-18

tings and HMI. Setup — Security Set- 3-7 Language Set-
Language tings and Configura- tings on page 3-20
Settings tions and Setup —
Language Settings.
STEP 2-3 Create the application (pages, Use HMI in the Multiv- | Section 4 Creating the
Creating the HMI | variables, subroutines, etc.) with iew Explorer of the HMI Application
Application the Sysmac Studio. Sysmac Studio.

1) Registering
Variables

* Register the variables in the HMI
global variable table with the
Sysmac Studio.

Note: Variables that were mapped
in step 2-2 are automatically regis-
tered in the HMI global variables
table.

Use the editor for HMI
— Data — Global Vari-
ables

4-1 Registering Vari-
ables on page 4-3

2) Creating Pages

» Paste the objects on each page
and set the object properties
and other settings.

Use the editor for HMI
— Pages.

4-3 Creating Pages on
page 4-14
Section 5 Objects

3) Creating Sub-

+ Create the subroutines.
You can create the following.
* Global subroutines

+ Page subroutines

Subroutines shared by
the entire project:
Select HMI — Global
Subroutine.

Page subroutines: Use

4-5 Subroutines on
page 4-39

routines HMI — Pages | Page
Name and select View
Code from the individ-
ual pages.
. * Make the settings that are Use HMI — User 4-4 Setting Common
4) Settings . . . )
shared by the project: alarms, Alarms, HMI — Reci- | Object Functions on
Shared by All . .
recipes, data logging, global pes, etc. page 4-22
Pages
events, etc.
STEP 24 » Convert the HMI project into a Use Build HMI on the | 4-8 Building on page

Building the HMI

form that the HMI can execute.

Project Menu.

4-48

STEP 2-5
Offline Debug-
ging

» Check the operation of the
pages on the Simulator (a virtual
HMI).

Use Start NA Simula-
tion or Run with Con-
troller Simulator on
the Simulation Menu.

Section 7 Debugging

NA-series Programmable Terminal Software User’s Manual (V118)
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® Setting HMI Variables First and Then Mapping Them to Connected Device

Variables
STEP 2-2 Create the application (pages, | Use HMI in the Multiview Section 4 Creating the
Creating the HMI | variables, subroutines, etc.) Explorer of the Sysmac Stu- | HMI Application
Application with the Sysmac Studio. dio.

1) Registering
Variables

Register the variables in the
HMI global variable table with
the Sysmac Studio.

HMI — Data — Global Variables
Table

4-1 Registering Vari-
ables on page 4-3

2) Creating Pages

Paste the objects on each
page and set the object prop-
erties.

Use the editor for HMI —
Pages.

4-3 Creating Pages on
page 4-14

Section 5 Objects

3) Creating Sub-

Create the subroutines.
You can create the following.
* Global subroutines

Subroutines shared by the
entire project: Select HMI —
Add Global Subroutine.

4-5 Subroutines on
page 4-39

routines i Page subroutines: Use HMI -
* Page subroutines Pages and select View Code
from the individual pages.
. Make the settings that are Use HMI — User Alarms, HMI | 4-4 Setting Common
4) Settings L . . ;
shared by the project: alarms, | — Recipes, etc. Object Functions on
Shared by All . .
recipes, data logging, global page 4-22
Pages
events, etc.
» Connecting to a Connected Device Registered in the Current Project
STEP 2-3 Make the initial software settings Use Configurations Section 3 HMI Config-

Software Set-
tings (Configura-
tions and Setup)

on the Sysmac Studio.

and Setup in the Mul-
tiview Explorer of the
Sysmac Studio.

uration and Setup

* Mapping Vari-
ables

ping variables).

+ Assign global variables to con-
nected device variables (map-

Map the variables
under Configura-
tions and Setup —
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

* HMI Settings

the HMI.

VNC Settings, etc.

» Set the parameters related to

Startup Page, Brightness Set-
tings, IP Address, FTP Settings,
NTP Settings, FINS Settings,

Make the settings
under Configura-
tions and Setup —
HMI Settings.

3-4 HMI Settings on
page 3-10

* Security Set-
tings and Lan-
guage Settings

on the HMI.

» Set the operation rights to the
HMI and the language to display

Make the settings
under Configura-
tions and Setup —
Security Settings and
Configurations and
Setup — Language
Settings.

3-5 Security Settings
on page 3-18

3-7 Language Set-
tings on page 3-20
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» Connecting to a Connected Device Not Registered in the Current Project

STEP2-3
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings
on the Sysmac Studio.

Use Configurations
and Setup in the Mul-
tiview Explorer of the
Sysmac Studio.

Section 3 HMI Config-
uration and Setup

* Connected
Device Settings

* Register the external connected
devices.

Add the connected
device under Configu-
rations and Setup —
Device References.

3-2 Device References
on page 3-3

* You can do either of the follow-
ing.

a) Importing Variables from the
Unit Connected Device:
Place the Sysmac Studio
online with the connected
device and import the vari-
ables from the connected
device.

b) Importing Variables from
Another Project: Copy the
variable table in the other
project and paste it in the
device variable table.

c¢) Importing Variables from a
File: Import the information
on the variables of the con-
nected device from a file,
such as an Excel file.

Set up communica-
tions and import the
variables.

Copy the variable table
from another project
using the clipboard.

Import variable infor-
mation from a file.

3-2-2 Connected
Devices in the Current
Project on page 3-3

* Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables
under Configura-
tions and Setup —
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

¢ HMI Settings

» Set the parameters related to
the HMI.
Startup Page, Brightness Set-
tings, IP Address, FTP Settings,
NTP Settings, FINS Settings,
VNC Settings, etc.

Make the settings
under Configura-
tions and Setup —
HMI Settings.

3-4 HMI Settings on
page 3-10

* Security Set-
tings and Lan-

+ Set the operation rights to the
HMI and the language to display
on the HMI.

Make the settings
under Configura-
tions and Setup —
Security Settings and

3-5 Security Settings
on page 3-18

3-7 Language Set-
tings on page 3-20

guage Settings Configurations and
Setup — Language
Settings.
STEP 2-4 » Convert the HMI project into a Use Build HMI on the | 4-8 Building on page

Building the HMI

form that the HMI can execute.

Project Menu.

4-48

STEP2-5
Offline Debug-

ging

» Check the operation of the
pages on the Simulator (a virtual
HMI).

Use Start NA Simula-
tion or Run with Con-
troller Simulator on
the Simulation Menu.

Section 7 Debugging
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STEP3

STEP4

Mounting and Wiring

Step Description Reference
* Mount the HMI to the panel. 3-3 Installing NA Units in NA Series Pro-
1) Mounting « Wire Power Supply. grammable Terminal Hardware User's Man-
ual (V117)
+ Wire the Ethernet cables. 3-4 Wiring Method in NA Series Program-
2) Wiring the

Ethernet Cable to
the Connected
Device

mable Terminal Hardware User's Manual
(V117)

NA-series Programmable Terminal Device
Connection User’s Manual (V119)

3) Connecting the
Computer (Sys-
mac Studio)

* Wire the USB cable.
or
* Wire the Ethernet cable.

2-4 Support Software in NA Series Program-
mable Terminal Hardware User's Manual
(V117)

Confirming Operation and Starting Actual System Operation

Step

Description

Sysmac Studio

. Reference
operations

1) Online Connec-
tion to Sysmac
Studio and Proj-
ect Download

» Turn ON the power supply to the
HMI and place the Sysmac Stu-
dio online. Then, download the
project.*1

*1.Use the Synchronize operation

of the Sysmac Studio to
download the project.

Use Communica-
tions Setup on the
HMI Menu.

Use Synchroniza-
tion on the HMI
Menu.

Section 6 Connecting
to the HMI and Section
8 Synchronizing Proj-
ects

2) Operation
Check on NA Unit

* Integrate the NA Unit into the
actual system, manipulate the
project that you created and
confirm the following: that cor-
rect values are written to the
connected device, that the
pages change correctly, and that
values set at the connected
device are updated.

- Section 7 Debugging

3) Actual System
Operation

« Start actual operation.
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Basic Sysmac Studio Operations

This section describes basic operations on the Sysmac Studio.
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2 Basic Sysmac Studio Operations

2-1 Parts of the Sysmac Studio Window

This section gives the names and functions of the parts of the Sysmac Studio Window.

This manual describes only functions that apply when an HMI is selected for the device. For information
on Sysmac Studio functions not described in this manual, refer to the Sysmac Studio Version 1 Opera-
tion Manual (Cat. No. W504).

|E| Precautions for Correct Use

When you use the Sysmac Studio, use the standard Windows desktop theme. If you do not use
the standard Windows desktop theme, part of the display may not be correct.

2-1-1  Application Window

Menu bar

Tab

Toolbar

Configurations —

and Setup Header

HMI Header —

(@)

Number

Name

(a) Multiview Explorer

(b) Edit Pane

(c) Toolbox

The functions of these parts are described starting on the next page.
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I Multiview Explorer (a)

* This pane is your access point for all Sysmac Studio data.

Multiview Explorer - 1 When an HMI is selected, it is divided into a Configurations
and Setup Layer and an HMI Layer.
HMI_MNAS5_0 v I __‘ + You can also display the Page Explorer to display lists of

objects on pages or the Code Explorer to display lists of

Ll Configurations and Setup subroutines.

eferences

MOpUI o1pn}s dewsAS ay o shed |-Z

& Variable Mapping
L] HMI Settings
%, Security Settings
@ Troubles
P Language Settings
M
¥ [if] Pages
LHEH
P wi) User Alarms
» [ Controller Events
= Data Logging
F= Data Groups
B Recipes
[ Custom Keypads
b [ Data

MopuIpA uoneoddy |-|-g

Events

Subroutines

@l Imported LAGs

If:'_"_l Scale Transformations

B Filter Ed
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® Layers and Items in the Multiview Explorer

Configurations and Setup HMI
Device References Pages
Variable Mapping Page
HMI Settings User Alarms
Security Settings Group
Troubleshooter Controller Events
Language Settings User Events
Data Logging
DataSet
Data Groups
DataGroup
Recipes
Custom Keypads
Data
Data Types

Global Variables
Global Events
Global Subroutines
Resources

Root
Imported IAGs
Scale Transformations

|E| Precautions for Correct Use

You cannot download the data to the HMI if an error icon is displayed.

® Page Explorer

The Page Explorer displays a list of objects on a page. If you click an object in the
Page Explorer, the object will be selected on the Edit Pane.

| To change the attributes for grouped objects or for individual objects in IAGs, select

@ oatctampo | ochane .
| the individual objects on the Page Explorer.

Page Explorer

® Code Explorer

The Code Explorer displays the subroutines in the project. You can double-click a
subroutine to edit it.

| Edit Pane (b)

The basic Sysmac Studio operations on the Edit Pane generally apply to HMIs. If an HMI is selected,
you can edit pages and set up the HMI.
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I Toolbox (c)

* The Toolbox shows the objects that you can use to edit the page that is displayed in
the Edit Pane.
You can also display the Properties Window, Animations Window, and Events and
Actions Window to make the settings of the objects.

MOpUIM o1pn]s oewisAS oy} Jo sped |-Z

MopuIpA uoneoyddy |-|-z
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2-2 Menu Command Structure

The menu commands that are displayed when an HMI is selected as the device are listed below.

Menu Submenu/command
File Close
Save
Save As
Save As New Number
Import —
Export
Page Settings
Print
Exit
Edit Undo
Redo
Cut
Copy
Paste
Delete
Select All
Search and Replace
View Multiview Explorer
Toolbox
Output Tab Page
Watch Tab Page
Cross Reference Tab Page
Build Tab Page
Search and Replace Results Tab Page
Page Explorer
Code Explorer
Properties
Animations
Events and Actions
Smart Project Search —
Recently Closed Windows —
Clear Recently Closed Windows History —
Zoom Zoom In
Zoom Out
Zoom to Fit
Zoom Reset
Reset Window Layout —

2-6 NA-series Programmable Terminal Software User’s Manual (V118)



2 Basic Sysmac Studio Operations

Menu

Submenu/command

Insert

Controller

NJ101

NJ301

NJ501

NX701

HMI

NAS

Measurement Sensor

Al

Vision Sensor

FQ-M

FH

Slave Terminal

Ethernet/IP Coupler

External Device

Page

Page Group

User Alarm Group

Data Set

Recipe

Global Subroutine Group

Project

Build HMI

Abort Build

IAG Collections Manager

HMI

Communications Setup

Change Device

Online

Offline

Synchronization

Transfer to Media Device

HMI Clock

Update HMI Name

Security

HMI Write Protection

Clear All Memory

Reset HMI Device

Simulation

Start NA Simulation

Stop NA Simulation

Step Execution

Step In

Step Out

Continue

Set/Clear Breakpoint

Clear All Breakpoints

Run with Controller Simulator

Tools

Option

Help

Help Contents

Keyboard Mapping Reference

Online Registration

About Sysmac Studio
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2 Basic Sysmac Studio Operations

2-3 Basic Editing Operations

This section describes differences in basic Sysmac Studio operation when an HMI is selected as the
device.

I Entry Assistance

There are some differences in the standard operation of the Sysmac Studio when an HMI is selected as
the device. This section describes those differences.

® Entering Variable Names and Data Types
» Entering variable names, e.g., when setting properties
« Entering data types in variable tables

Example: When you enter a variable name as a property, the variable names that you can enter are
displayed in a list.

Variable bll

IsEnabled +# blnValuel Boolean binValus0

@ binValuel
@ binValue2
Y

DoubleTouchTime]
OnDelayTime
OffDelayTime
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2 Basic Sysmac Studio Operations

® Entering Text in the Code Editor

* When you enter text in the Code Editor, the cursor moves to the first item in the list that starts with
the character that you entered.

suonesado Bunip3 siseg ¢-z

. Whén you press the Tab Key after entering the first part of the keyword (“in” in this example), the
rest of the keyword is automatically entered.
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2-4 Sysmac Studio Settings and Opera-
tions

This section lists the operations of the Sysmac Studio that can be used only when an HMI is selected.

2-4-1 Setting Parameters

Item Description Reference
HMI Settings You can make settings for an HMI. Section 3 HMI Configuration
and Setup
Device References If you connect an HMI to a device (e.g., Control- | 3-2 Device References on

ler or PLC) that is not registered in the current | page 3-3
HMI project, the connected external device will
be added.

Internal Device Controllers registered in the project are dis-
played.

External Device You can set up communications and import vari-
ables for connected devices that have been
added.

Variable Mapping You can associate variables in the connected 3-3 Mapping Variables on
devices with variables in the HMI. page 3-7

2-4-2 Programming

Item Description Reference
Toolbox The Toolbox displays a list of the objects that Section 5 Objects
you can use.

You can search for the required objects and
drag them to the Page Editor to position the
objects.

Properties You can set the static attributes of the pages
and objects.

Animations You can set the operations for object condition
expressions.

Events and Actions You can set the actions to perform when events
occur.

Page Explorer The Page Explorer displays a list of objects on a
page. You can select objects or change the
order of the display.

Code Explorer The Code Explorer displays lists of subroutines
in the project. You can double-click a subroutine
to edit it.

Page Editor You can position objects and create pages. You | 4-3 Creating Pages on page
can also use the Page Editor to make settings | 4-14

for objects.
Code Editor You can use Visual Basic to create subroutines. | 4-5 Subroutines on page 4-39
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Item Description Reference
Search and Replace You can search and replace strings in project 4-6 Search and Replace on
data. page 4-46
Cross Reference Searches the area where the search target is 4-7 Cross References on
allocated, and displays a list. page 4-47

Build Build HMI Convert the project into a form that the HMI can
execute.
Abort Build You can abort a build operation.

4-8 Building on page 4-48

2-4-3 Library Functions

Reference

Item Description
Toolbox You can register objects that you have created
and then reuse them.
IAG You can output an IAG that you created in an

IAG project as an IAG collection, to use it in
another project.

Section 9 Reusing Objects

2-4-4 Operations for Debugging

2-4-5

2-4-6

Item

Description

Reference

Monitoring

You can monitor variables during project execu-
tion.

You can monitor the present values of HMI
global variables. You use the Watch Tab Page
for monitoring.

Section 7 Debugging

Changing the Present Values
of Variables

You can change the present values of global
variables and system-defined variables.

You can do this on a Watch Tab Page.

Section 7 Debugging

Controlling Execution with
Breakpoints and Step Execu-
tion

You can control simulation execution to monitor
the program or to check operation.
Step execution and pausing are also possible.

Section 7 Debugging

Communications

Item

Description

Reference

Going Online with an HMI

You can place the computer online with an HMI
to synchronize the project.

Section 6 Connecting to the
HMI

Security Measures

Item Description Reference
Prevention of Confirming HMI If the device name or the serial ID is different 3-5 Security Settings
Incorrect Con- device Names and | between the project and the HMI when an on page 3-18
nections Serial IDs online connection is established, a confirmation
dialog box is displayed.
Preventing Incor- | Operation Author- | You can use operation authorities to restrict the
rect Operation ity Verification ability to perform operations or display data.
NA-series Programmable Terminal Software User’s Manual (V118) 2-1
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2 Basic Sysmac Studio Operations

Item

Description Reference

Prevention of the | Password Protec-
Theft of Assets tion for Project
Files

You can set password protection for project files
to protect your assets.

2-4-7 Online Help

Item

Description Reference

Sysmac Studio Help System | You can
cedures.

access Sysmac Studio operating pro-

Keyboard Mapping Reference | You can

keys that you can use on the Sysmac Studio.

display a list of convenient shortcut
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2-5 Basic Operations for HMI Projects

This section describes how to create and save projects and perform other basic operations to use
HMIs.

2-5-1 Creating a Project File from the Project Window

syoaloid |INH 410} suonesadQ siseg G-g

Use the following procedure to create a project file from the Project Window.

1 Click the New Project Button in the Project Window.

/ Project Window

The Project Properties Dialog Box is displayed. The following table gives the functions of the

buttons.
Menu command Description
New Project Button Creates a project file.
Open Project Button Opens an existing project file.

MOPUIAN 198(01d 8y} woJj )14 108loid e Bunesiy |-G-g

2 Enter the project name, author, and comment in the Project Properties Dialog Box, select HM/
from the device category, and then click the Create Button. (Only the project name is required.)

You can change the properties later. Refer to the Sysmac Studio Version 1 Operation Manual
(Cat. No. W504).

A project file is created and the following window is displayed.
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A project file is created with the specified device already inserted.

2-5-2 Adding an HMI to an Existing Project

Right-click the Controller Icon and select Add Device from the menu.

Or, select the device directly from the Insert Menu.
Example: HMI - NAS: The Add Device Dialog Box is displayed.

Add Device

[ . _
B Select Device

Category HMI -
Device MAS ¥ - 12W101O -

Version v

Select the device and then click the OK Button. The device is added to the project.
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To change the target device, select a device from the list.

2-5-3 Changing Devices

Right-click the HMI Icon and select Change Device from the menu. Or, select Change Device from the
HMI Menu.

syoofoad |INH 103 suoneladQ siseg G-

The Change Device Dialog Box is displayed.

Change Device

'.ﬂﬂ Select Device

Category HMI
Device NAS

Version

saol1neg Bulbuey) €-G-z

Select the device and then click the OK Button. The device is changed.

|-_l7] Precautions for Correct Use

+ If you change the device, the settings for functions that are not supported by the new model
will be lost.

+ If you change to a model that has a different display size, the objects will be enlarged or
reduced according to the new display size. However, elements other than objects, such as
font sizes, will not change.

I HMI Versions

Set the version when you create a new HMI project or when you add an HMI to an existing project.

You can set the version to the runtime version of the HMI that you are using. You can program and
make settings within the ranges that are supported for the runtime version. If you attempt to use func-
tions that are not supported by the runtime version that you set, you will not be able to use them or
errors will occur.

@ Additional Information

When you open the project that was created in past versions of the Sysmac Studio version 1.11
or higher, it will be converted as follows.

Version of the Runtime Sysmac Studio
before conversion V1.10 V1.11 or V1.12 V1.13 V1.14
1.00 1.00 1.011 1.02" 1.03
1.01 1.01 1.02"1 1.03™1
1.02 1.02 1.03™
1.03 - 1.03

*1. The runtime version will be converted.
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HMI Configuration and Setup
]

This section describes how to configure and set up HMIs on the Sysmac Studio, includ-
ing mapping variables with connected devices and HMI settings.

3-1 Outline of Configurationsand Setup ............... ... ... ... 3-2
3-1-1  Connected Device Registration and Variable Mapping . ... ............... 3-2
3-2 Device References . .........c.ouiiiiiiiniii ittty 3-3
3-2-1  Typesof Connected Devices ........ ... ..t 3-3
3-2-2  Connected Devices in the Current Project . .......... ... ... ... ... ..... 3-3
3-2-3  Registering External Connected Devices ............................. 3-4
3-3 Mapping Variables .......... ... e 3-7
3-3-1  Mapping Variables .. ....... ... . e 3-7
3-3-2  Opening the Variable Mapping Tab Page and Tab Page Parts . ... ......... 3-7
3-3-3 Variable Mapping Methods . .......... ... . ... 3-8
3-4 HMISettings ....... ..o iiiiiii it it e e ne e nnns 3-10
3-4-1 HMISettings ... ..o 3-10
3-4-2  Device Settings . .. ... 3-11
3-4-3  TCP/IP Settings ... ...t 3-12
3-4-4  FTP Settings . .. ..ot 3-13
3-4-5 NTP Settings . ... ..o 3-14
3-4-6  FINS Settings .. ... . 3-15
3-4-7 VNC Settings . ... 3-16
3-4-8  Printing Settings .. ... .. 3-17
3-5 Security Settings ......... .. e e 3-18
3-6 Troubleshooter ......... ... .ttt inaaenanenns 3-19
3-7 Language Settings .......... ... e e 3-20
3-8 HMICIoCK . ... .. i e et e et aaaens 3-21
3-9 Updatingthe HMIName . .......... ... .. . i, 3-22
3-10 Write Protectingthe HMI . .. ...... ... ... ... . . i, 3-23
311 Clear AlIMEmMOryY . .. ...ttt et e a e an e 3-24
3-12Resettingthe HMI . . ... ... ... ... e e 3-25
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3 HMI Configuration and Setup

3-1

3-1-1

Outline of Configurations and Setup

This section describes how to set up HMIs and connected devices, such as Controllers and PLCs. The
following items are provided in the HMI Configurations and Setup.

Item

Description

Device References

You can set up connected devices and import variables.

Variable Mapping

You can assign HMI variables to the variables in the connected devices.

HMI Settings

These are the parameters related to the HMI.

Security Settings

You can set up restrictions to operations on HMIs.

Troubleshooter

You can set parameters for the Troubleshooter.

Language Settings

You can make settings for multi-language projects.

Connected Device Registration and Variable Mapping

Device references must be set only to connect to external devices that are not registered in the current
project. They are not necessary to connect to a Controller that is registered in the current project.

The following figure shows the relationship between connected device references and variable map-

ping.

The HMI global variables are mapped to the connected device variables.

To access variables in the connected devices from an HMI, you must map the variables.

Sysmac Studio Project

Pages

Page 1

e T

Object Properties

Object

-
L — Behaviour | e

Expression NGontroller)_aa.

(E) Selectable

| |Variable hame [ pata type
 Control ler0_asa |Rolean

ontr Integer

m Variable Map m_Connected Device References
(C)Mapping Global variables of connected devices External device
Position Data type m%me E? atT type
aaaBoolean{Control ler0_aaa || aaa oolean
BFb | Integer| Contro] Tergbbb Integer (s Varialescopid hough he cphoad o ofrer
projects or varables imported by accessing the

physical device (PLC or Conlroller)

(D) Automatic registration

(A importing comected

Selectable

device variables
(B) Automatic registration ;) e amaicay mted o Cortles e

Internal
device

(A) Connected device variables are a) automatically imported from the same project or b) copied from
another project or manually imported from an external device or a file, such as an Excel file.

—_ =~~~
9]
—-—— =

The connected device variables are automatically registered in the variable mappings.

The HMI global variables are mapped to the connected device variables.

The mapped HMI global variables are automatically registered in the global variable table of the HMI.
You specify HMI global variables in the object properties.
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3-2 Device References

This section describes how to set up HMIs and connected devices, such as Controllers and PLCs.

3-2-1 Types of Connected Devices

Different operations are used to connect to Controllers that are registered and Controllers that are not

registered in the current project.

» Controllers that are already registered in the current project are automatically registered in the HMI
project as internal connected devices.

» To connect to a device that is not registered in the current HMI project, you must register the device
as an external connected device.

S9oUaIBYeY 99IAeQ Z-€

@ Additional Information

If you upload a project that includes Controllers registered as internal connected devices to a
project in which the Controllers are not registered, the devices are registered as internal con-
nected devices that do not have links to Controllers. Refer to 8-1 Synchronizing Projects on
page 8-2 for details.

3-2-2 Connected Devices in the Current Project

S80IA8( PBJoBUU0) Jo sedA) |-Z-€

Controllers that are registered in the current project are displayed as connected devices. Use the fol-
lowing procedure to display the device settings if you need to check them.

1 Click Device References under Configurations and Setup in the Multiview Explorer.
2 The Controllers that are registered in the current project are displayed under Internal Device.

3 Double-click the project to display the following Device Configuration Tab Page.
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3-2-3 Registering External Connected Devices
To connect the HMI to a device that is not registered in the current HMI project, you must register the

device as an external connected device. The procedures to register and set up external connected
devices are given below.

I Registering and Setting Up External Connected Devices

This section describes how to register and set up external connected devices.

1 Right-click Device References under Configurations and Setup in the Multiview Explorer.

2 Select Add - ExternalDevice. The device is added as ExternalDeviceld, where O is a serial
number starting from 0.

Multiview Explorer

—
HMILNAS_0 ||___ J.|

¥ Configurations and Setup

@ Internal Devices Add v

+* Variable Mapping

3 Double-click the new ExternalDevicel.
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3 HMI Configuration and Setup

4 Select the vendor of the required device in the Device Vendor Box under Device Configura-
tion. The device series of the selected vendor is displayed. Make the selections for the required
device. The device communications drivers of the vendor selected for the device series are dis-
played. Select the communications driver for the required device.

S9oUaIBYeY 99IAeQ Z-€

5 Make the required settings in the Communications Configuration Area. Refer to the NA-series
Programmable Terminal Device Connection User’s Manual (Cat. No. V119) for details.

$80IA8( PBJoBUU0) [eusd)x] Bulelsibey ¢-z-¢
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I Importing External Connected Device Variables

To connect the HMI to a device that is not registered in the current HMI project, you must import the
variables from the external connected device.

There are three ways to import external connected device variables.

+ Importing device variables online from the actual external connected device
» Copying variables from the variable table in another project

 Importing variables from an Excel or CXT file

® Importing Device Variables Online from the Actual External Connected
Device

Click the Import Variables Button. The variables are imported from the external connected device.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)
for details.

® Copying Variables from the Variable Table in Another Project

You can use the clipboard to copy the required variables from the Support Software for the con-
nected device and paste them in the device variables table for the external connected device. How-
ever, you cannot copy connected device variables if they are structure variables.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)
for details.

® Importing Variables from an Excel or CXT File

Click the Import from File Button. The variables are imported for the external connected device.
Refer to the NA-series Programmable Terminal Device Connection User's Manual (Cat. No. V119)
for details.

I Updating Device Variables

If you change the variables on a device, update the device variables in the HMI project as required.

There are three ways to update device variables.

» Updating device variables online from the actual external connected device
» Copying variables from the variable table in another project

 Importing variables from an Excel or CXT file

® Updating Device Variables Online from the Actual External Connected Device

Click the Update Variables Button. The differences between the variables on the external con-
nected device and the device variables in the HMI project are displayed. Select the variables to
update.

® Copying Variables from the Variable Table in Another Project
You can use the clipboard to copy the required variables from the Support Software for the con-
nected device and paste them in the device variables table for the external connected device.

® Importing Variables from an Excel or CXT File

Click the Import from File Button. The differences between the variables in the Excel file and the
device variables in the HMI project are displayed. Select the variables to be updated.
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3-3 Mapping Variables

This section describes the settings required to access variables in connected devices through HMI
global variables.

3-3-1 Mapping Variables

Mapping variables refers to assigning variables in devices connected to the HMI (called device vari-
ables) to global variables in the HMI. Device variables are used on the HMI by assigning them to HMI
global variables.

Therefore, mapping variables is required. Not accessing device variables directly allows you to reuse
projects simply by changing the variable mappings.

sa|qeliep Buiddepy ¢-¢

w

Global variables that are assigned to device variables are called external variables.

3-3-2 Opening the Variable Mapping Tab Page and Tab Page Parts

1 Double-click Variable Mapping under Configurations and Setup.
The Variable Mapping Tab Page is displayed.

so|qelep Buiddepy L-¢-¢

Variable Mapping X
Position | Port | Data Type | Variable | Variable Comment
_§ Configured Devices

I Parts of the Window

No Item Description
1 Position Displays the IP addresses of the connected devices.
2 Port Displays the connected devices and device variables in a tree structure.
3 Data Type The data types of the device variables are displayed.
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No Item Description
4 Variable You can set the name of a HMI global variable. You can use entry assistance to
select from a list of previously registered HMI global variables.
5 Variable Comment | You can set comments for the HMI global variables. These comments are also

applied to the global variable table.

3-3-3 Variable Mapping Methods

To map variables, you can either create new global variables and assign them or you can assign previ-
ously created global variables.

To increase the reusability of the project, create the global variables first and then assign them.

However, if a device variable is a structure, you must create a new external variable during variable
mapping.

I Creating New External Variables

You can create a new global variable and assign it to a device variable.

When you create an external variable, you can either have the name generated automatically or you
can create it manually.

® Automatically Creating New Variable Names

Use the following procedure.

1 Select one or more device variables in the variable mappings, right-click, and select Create
Device Variable from the popup menu.

Automatically generated variable names are registered in the global variable table according to

the following rule.

Automatic generation rule: The device variable name is added after the controller name and
separated with an underline.

® Manually Entering New Variable Names

Select the device variable and directly enter the variable name in the Variable column.
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Selecting Previously Registered Global Variables and Mapping
Them

You can select global variables that are already registered in the global variable table and assign them
to device variables.

For example, this method can be used to map external variables in the following cases.
+ Setting an HMI global variable first and then assigning it to a device variable
» Creating a common project first and specifying connected devices later

Use the following procedure.

sa|qeliep Buiddepy ¢-¢

1 Register the global variables in the global variable table in advance.

2 When you map variables, you can select global variables from lists of variables that are already
registered in the global variable table and assign them to device variables.

spoyaiy Buiddeyy ajgqeueA ¢-¢-¢
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3-4 HMI Settings

This section describes the HMI settings.

3-4-1

HMI Settings

You can make settings for an HMI.

The following table lists the setting items.

Item

Icon

Description

When setting is required

Device Settings

There are page, screen saver,
brightness settings, and other set-
tings.

These settings are always required.

TCP/IP Settings These are the Ethernet settings for | These settings are always required.
Ethernet ports 1 and 2.
FTP Settings These are the FTP server settings. | These settings are required to use

the FTP server.

NTP Settings

These are the NTP client settings.

These settings are required when
you use an NTP client.

FINS Settings

These are the settings for FINS com-
munications.

These settings are required when
using FINS communications with a
CJ-series PLC.

VNC Settings

These are the VNC settings.

These settings are required to use
VNC.

Print Settings

These are the settings for printing
and capturing screens on the HMI.

These settings are required to print
or capture screens.

I Setting Procedure for HMI Settings

1 Double-click HMI Settings under Configurations and Setup in the Multiview Explorer. The
HMI Settings Tab Page is displayed in the Edit Pane.

2 Click the icons on the left to display the corresponding dialog boxes.
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3-4-2 Device Settings

These are the device settings.

3 HMI Configuration and Setup

Item

Description

Startup Page

| Page name

Sets the page to display first when the HMI is started.

Startup Language

| Startup language

Sets the project language to use when the HMI is started.

Software Keypads/USB Keyboard

System Keypad Size

Sets the display size of the system keypad.

USB Keyboard layout

Sets the layout of the USB keyboard.

Security

period of inactivity.

Automatically log out user after

Select this check box to automatically log out the user after a specified
period of inactivity.

Inactivity period

Specify the time of inactivity before the user is logged out automatically.

Screen Saver

Screen saver type

Sets the type of screen saver.

Active after

Sets the time after the screen is touched before the screen saver is started.

Screen Brightness

Screen brightness

Sets the brightness of the screen.

System Menu

Double-tap Interval

Sets the interval to use to detect double taps.

Detectable corner

Select the corners in which to detect the operation to display the System
Menu.

Sound

Touch Input Notification

Sets whether to beep when an input is accepted.

Alarm Notification

Sets the buzzer that is beeped when an alarm occurs, specifically, the type
of buzzer and the user alarm level.

Internal Retained Memory Settings

Maximum Number of User
Alarm Logs

Sets the maximum number of alarm logs to save in the NA.
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3 HMI Configuration and Setup

3-4-3

TCP/IP Settings

These are the settings for TCP/IP.

The following settings are provided for Ethernet port 1 and Ethernet port 2.

Item

Description

Ethernet Port 1 - Settings

IP Address

Sets the local IP address.

Subnet mask

Sets the subnet mask.

Default gateway

Sets the IP address of the default gateway. This setting is not required when
a default gateway is not used.

Primary DNS server

Sets the IP address of the primary DNS server.

Secondary DNS server

Sets the IP address of the secondary DNS server.

Primary WINS server

Sets the IP address of the primary WINS server.

Secondary WINS server

Sets the IP address of the secondary WINS server.

Et

hernet Port 2 - Settings

Direct connection with Sys-
mac Studio

Select this check box to connect Ethernet port 2 directly to the Sysmac Stu-
dio without going through an Ethernet switch. If you select this check box,
the IP addresses and other settings for Ethernet port 2 are ignored.

IP Address

Sets the local IP address.

Subnet mask

Sets the subnet mask.

Default gateway

Sets the IP address of the default gateway. This setting is not required when
a default gateway is not used.

Primary DNS server

Sets the IP address of the primary DNS server.

Secondary DNS server

Sets the IP address of the secondary DNS server.

Primary WINS server

Sets the IP address of the primary WINS server.

Secondary WINS server

Sets the IP address of the secondary WINS server.

NA-series Programmable Terminal Software User’s Manual (V118)



3 HMI Configuration and Setup

3-4-4 FTP Settings

These are the FTP server settings.

FTP

FTP server © Donotuse @ Use

Login name. [E—
Password |

sbumes INH t-€

w
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Item Description
FTP Settings
FTP server Specifies whether to use the FTP server of the HMI.
Login name Sets the login name to externally connect to Ethernet port 1 or 2 on the HMI
via FTP. You can use up to 12 alphanumeric characters.
Password Sets the password to use to externally connect to Ethernet port 1 or 2 via FTP.
You can use 8 to 32 alphanumeric characters.
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3-4-5 NTP Settings

These are the settings for an NTP (Network Time Protocol) client.

The HMI gets the clock information from the specified NTP server at the specified interval and updates
the built-in clock information.

B Synchronize with an Internet time server
TEE e sener [

Item Description
NTP Settings
Synchronize with an Internet | Select this check box to synchronize the built-in clock in the HMI with the
time server clock information from the NTP server.
NTP server Sets the IP address of the NTP server.
Interval Sets the interval at which to get the clock information from the NTP server.

3-14 NA-series Programmable Terminal Software User’s Manual (V118)



3-4-6 FINS Settings

3 HMI Configuration and Setup

These are the settings for FINS communications.
These settings are required when FINS communications are used between the HMI and a CJ-series

PLC.

Item

Description

FINS Address

Ethernet port #1

Sets the FINS network address of Ethernet port 1.

The FINS node address is automatically created from the IP address.

Ethernet port #2

Sets the FINS network address of Ethernet port 2.

The FINS node address is automatically created from the IP address.

FINS/UDP

FINS/UDP port no

Displays the port number used for FINS/UDP.

Remote Network Table

Sets the routing table.
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3 HMI Configuration and Setup

3-4-7 VNC Settings

These are the settings for VNC (Virtual Network Computing).

VNC implements a remote desktop to allow remote control of a computer located on a network.

You must enable the server functionality on the HMI to control. You can start the client software on the
computer from which to perform remote control, connect to the HMI, and then control it remotely.

Item Description
VNC Settings
VNC Server Specifies whether to use VNC.
Port No. Sets the port number.
Mode Sets the operations to enable from the VNC client.
Password Sets the password.

Enable VNC multiple login

Specifies whether to allow multiple clients to log in.

Enable registered client login

Specifies whether to allow only certain clients to log in.

IP Address Registers the IP addresses of the client devices to be allowed
to log in.

MAC Address Registers the MAC addresses of the client devices to be allowed to log in.
(e.g., 3D:F2:C9:A6:B3:4F).

Comment Specifies a comment.
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3-4-8 Printing Settings

These are the settings for printing and capturing screens on the HMI.

You can capture screens displayed on the HMI.

sbumes INH #-¢

sbumes Bunuud g--¢

Item Description
Printing Settings

Color Mode Sets one of the following options for the number of colors or use of highlight-
ing:
+ Color
+ Grayscale
* Reverse Grayscale

Print With Title Sets whether to print the page title.
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3-5 Security Settings

These settings are used to restrict the operations that can be performed on the HMI and register
accounts.

I Setting Procedure for Security Settings

1 Double-click Security under Configurations and Setup in the Multiview Explorer.
The Security Settings Tab Page is displayed in the Edit Pane.

¥ User Accounts

: Mame | Password | Role | Comment
: Administrator R Administrator Default Administrator

¥ Roles and Access Levels

Role / Access Level | Level 1| Level 2| Level 3| Level =1| Level 5

Administrator 1 1 1 1 1

+
¥ Security Settings

System Menu Level [None ¥

Item Description

User Accounts

Registers user accounts.

Roles and Access Levels

Sets the access level for each role.

Security Settings

Sets the level of operations to permit from the System Menu.

NA-series Programmable Terminal Software User’s Manual (V118)
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3-6 Troubleshooter

These settings are used for the troubleshooter for the NJ/NX series.
Refer to the NA-series Programmable Terminal Hardware User's Manual (Cat. No. V117) for details.

Jajooysa|qnoil 9-¢
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3-7 Language Settings

These settings are used for multi-language projects.

I Project Language and System Language

There are two languages on the HMI.

* Project Language

The project language is displayed for the project that you create.

» System Language

The system language is displayed for the System Menu and for error messages displayed by the sys-

tem.

The two language settings are managed as pairs. If you change the project language, the paired sys-

tem language will also change.

I Language Setting Procedure

1 Double-click Language Settings under Configurations and Setup in the Multiview Explorer.
The Language Settings Tab Page is displayed in the Edit Pane.

Item

Description

Default language

Sets the language that is displayed by default.

Other languages

Sets the languages to add in addition to the default languages.

System languages

Sets the language to display system menus or system error messages.

Software keypads

Sets whether to use the default system keypad or a custom keypad.

@ Additional Information

You can clear the selection of the Transfer to Device Check Box so that the language files are
not transferred to the HMI. You can use this to delete unnecessary languages depending on the

destination of the HMI.

NA-series Programmable Terminal Software User’s Manual (V118)
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3-8 HMI Clock

To set the clock in the HMI, select HMI Clock from the HMI Menu when you are online. Set the required
items and click the Apply Button to update the information in the HMI.

HMI Clock

~Timefone

Computer
(UTC-08:00) Pacific Time (US & Canada) JELULS

¥20ID INH 8-€

Date and time
Computer HMI

6/5/2014 6/5/2014  |[aa
»> Synchronize with computer > >
12:14:51 03:12:12

w

Item Description
Time Zone
Computer Displays the time zone of the computer.
HMI Sets the time zone of the HMI
Automatically adjust clock for | Select this check box to enable automatically adjusting for daylight savings
DST time.
Date and time
Computer Displays the current date and time on the computer.
Synchronize with computer Updates the clock information on the HMI with the clock information from the
computer.
HMI Set the clock information on the HMI.
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3-9 Updating the HMI Name

To change the HMI name, select HMI Name from the HMI Menu when you are online.

A confirmation dialog box is displayed. To update the HMI name that is set in the project, click the Yes
Button.

Sysmac Studic

The HMI Unit named [HMI_MAS_0] will be updated with the name from the project [HMLNAS5_1].
Do you want to continue? (¥/MN)
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3 HMI Configuration and Setup

3-10 Write Protecting the HMI

To write-protect the HMI, select Security - HMI Write Protection from the HMI Menu when you are
online.

A confirmation dialog box is displayed. Click the Yes Button to write-protect the HMI.

IINH 2y} Bunoajoid )M 01-€

Only the project is write-protected. The project can still log data and write other data.
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3 HMI Configuration and Setup

3-11 Clear All Memory

You can initialize the HMI.

When you perform the Clear All Memory operation, all data is cleared except for time data. To clear all
memory in the HMI, select Clear All Memory from the HMI Menu when you are online.

A confirmation dialog box is displayed. Click the OK Button to clear all memory.
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3-12 Resetting the HMI

You can reset the HMI.

To reset the HMI, select Reset HMI Device from the HMI Menu when you are online. A confirmation
dialog box is displayed. Click the Yes Button to reset the HMI.

Sysmac Studio

This operation resets the HMI device. Make sure resetting will cause no problems for access to 5D Memory Card.

It goes offline after resetting.
Go online again after starting the HMI

INH @y} Bumesay zi-¢

Do you want to reset? (Y/N)

w
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Creating the HMI Application

This section describes how to create the HMI application (pages, variables, subrou-
tines, etc.) with the Sysmac Studio.

41
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4 Creating the HMI Application

4-1 Registering Variables

4-1-1 Variables

A variable is a ‘container’ that holds data.

The HMI supports the following types of variables.
Variable type Description
Global variables Global variables are defined by the user and can be accessed from anywhere in the

project. You can register up to 35,000 total in the entire project and up to 30,000 for

each connected device."

Global variables are declared in the HMI global variable table.

Global variables include external variables and internal variables, which are
described below.

External variables External variables are global variables that are used to access data in Controllers
and other connected devices.

so|qeliep Buuaysibay |-

External variables are assigned to device variables in the variable mapping.
Internal variables An internal variable can be used only within the HMI.

All global variables that are not external variables are internal variables.

S9|qeleA |-L-y

System-defined | System-defined variables are provided in advance in the HMI. The names and all
variables attributes are defined by the system. They have specific functions.
You cannot change the variable names or any other attributes of these variables.
Subroutine variables Subroutine variables are defined by the user and are used only within subroutines.

Subroutine variables are declared in Dim statements in page subroutines or global
subroutines.

You can use all of the data types that are supported by Visual Basic.

*1. For the Runtime version 1.02 or lower, the registerable numbers are up to 35,000 in the entire project, and up
to 20,000 for each connected device.
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4 Creating the HMI Application

4-1-2 Registering Global Variables

® Opening the Global Variable Tab Page

Double-click Global Variables under HMI - Data in the Multiview Explorer. Or, right-click Global
Variables under HMI - Data and select Edit from the menu.

The global variable table is displayed in the Edit Pane.

] Data Type | Initial Value | AT Scaling | Comment

HMI_binValuel
HMLintValuel

The basic Sysmac Studio operations for the global variable table generally apply to HMIs. Refer to
the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for the basic operations.

However, the following items are different. Refer to 4-1-4 Attributes and Entry Methods for Global
Variables on page 4-6.

Item Description

Name There are specific prohibited characters that apply to HMIs.

Data Type There are specific data types for HMIs.

AT You can set the device variables to which to assign the global variables. This setting is
not used for internal variables.

Update Rate You can select the interval at which to get values from the connected device. This set-
ting is used only for external variables.

Scaling You can select a conversion expression for the value obtained from the connected
device. This setting is used only for an external variable.

@ Additional Information

Even if you change the name of a previously registered global variable, the name of the vari-
able accessed from objects or subroutines will not change.
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4-1-3 Registering External Variables

I External Variables

External variables are global variables that are used to access data in connected devices.

I Creating External Variables

External variables are created in the variable mapping.

The global variables are mapped to the connected device variables.

In the variable mapping, you can create new variables or you can select variables that were previously
created.

If you create a new external variable in the variable mapping, it will automatically be registered as a
global variable.

so|qeliep Buuaysibay |-

Refer to 3-3 Mapping Variables on page 3-7 for details on the variable mapping.

I Attributes of External Variables

If you create a new external variable in the variable mapping, the following attributes are registered for
it in the global variable table.

Refer to 4-1-5 System-defined Variables on page 4-9 for details on the attributes of variables.

sa|qeue) [eusa)xg buueisibey ¢-|-i

Attribute Setting Chang_es to set-
tings
Name Specified variable name Possible.
Data Type Refer to the NA-series Programmable Terminal Device Connection | Possible.
User’s Manual (Cat. No. V119) for details on data type for the HMI
global variables based on data types for device variable.
Initial Value None Not possible.
AT Device _name.Device variable _name Possible.
Retain Non-retained Not possible.
Constant None Not possible.
Update Rate 500 ms Possible.
Scaling None Possible.
Comment Specified comment Possible.
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4-1-4 Attributes and Entry Methods for Global Variables

This section describes attributes and entry methods for global variables.

| Attributes of Global Variables

® Name Attribute

[ ]

Enter a text string for the name. Observe the following restrictions.

You cannot use any symbols except for underscores.

The first letter cannot be a number.

The names are not case sensitive.

You cannot use names that start with “_ HMI”, * eHMI_”, “ sHMI_”, “ uHMI_”, or “_SyxSPC_".
You cannot use names that are reserved for the Sysmac Studio or Visual Basic.

You cannot use more than 127 characters.

You cannot use three underscores in a row.
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® Data Type Attribute

Enter a data type directly or select one from the list.

You can use the following data types, which are supported by Visual Basic. Arrays of the data types that

are supported by Visual Basic are also supported. If you specify an array, specify the element number »
in parentheses after the data type in the same way as in Visual Basic. ;
1]
Q
Clas_S|f|ca- Data type Data type Size Range of values 5’
tion name 5
Basic data Boolean Boolean — True or False Q<
types Byte Byte 1 byte 0 to 255 (unsigned) %
Char Char 2 bytes 0 to 65,535 (unsigned) %

Date Date 8 bytes 0:00:00 (midnight) on January 1, 0001 through

11:59:59 PM on December 31, 9999
Decimal Decimal 16 bytes | O through

+/-79,228,162,514,264,337,593,543,950,335
(+/-7.9...E+28) with no decimal point;

0 through +/-7.9228162514264337593543950335
with 28 places to the right of the decimal;

smallest nonzero number is
+/-0.0000000000000000000000000001 (+/-1E-28)
Double Double 8 bytes -1.79769313486231570E+308 through
-4.94065645841246544E-324 for negative values;

4.94065645841246544E-324 through
1.79769313486231570E+308 for positive values

S8|qeleA [BO|D JO} SPOYIBIN AJug pue SeNqupy - |-

Integer Integer 4 bytes -2,147,483,648 through 2,147,483,647 (signed)
Long Long 8 bytes -9,223,372,036,854,775,808 through
9,223,372,036,854,775,807 (9.2...E+18) (signed)
SByte SByte 1 byte -128 through 127 (signed)
Short Short 2 bytes -32,768 through 32,767 (signed)
Single Single 4 bytes -3.4028235E+38 through -1.401298E-45 for negative
values;
1.401298E-45 through 3.4028235E+38 for positive
values
String String Variable 0 to approximately 2 billion Unicode characters
length
Ulnteger Ulnteger 4 bytes 0 through 4,294,967,295 (unsigned)
ULong ULong 8 bytes 0 through 18,446,744,073,709,551,615 (1.8...E+19)
(unsigned)
UShort UShort 2 bytes 0 to 65,535 (unsigned)
Derivative TimeSpan Structure that gives a time interval
data types Structures/ This is a user-defined data type that integrates different data types into a single
Unions/ group.

Enumerations | vou can name the data type.

Specify the name of the variables that use the user-defined data type, and one
of the member variables included in the group.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119) for
information on which of the above HMI variable data types can be assigned to the data types of con-
nected device variables for different connected devices.
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® Initial Value Attribute

Data Type Initial Value AT Retain | Constant | Update Rate Comment
[ [

Specify a value for the variable for one of the following situations when the Retain attribute is not
specified.

* When the power supply is turned ON

* When you specify to initialize the value when the project is transferred

Enter a value directly or select an item from the list (the values in the list depend on the data type). If
you do not enter an initial value, 0 is used as the initial value.

Select None for no initial value. You cannot specify the Initial Value attribute for an external variable.

® AT Attribute

Data Type Initial Value Retain | Constant | Update Rate Comment
[ L]

This attribute is specified for external variables. Use the following format.

Device_name.Device variable_name

® Retain Attribute

Specify whether to retain the value of the variable in the following cases.
* When the power supply is turned ON
» When you do not specify to initialize the value when the project is transferred

You cannot specify the Retain attribute for an external variable.

® Constant Attribute

| DataType | InitilValue | AT | Reta ‘UpdateRate |  Salng | Comment |

If you set the Constant attribute, you can set the initial value of the variable when the project is
downloaded, but you cannot overwrite the value afterward.

You cannot specify the Constant attribute for an external variable.
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4 Creating the HMI Application

® Update Rate Attribute

Glebal Variables X

Initial Value AT Retain | Constgpt Update Rate Comment
HMI_binValuel 500 Millisecor, v (=1 13

The update interval with the connected device is specified for external variables. If None is set for an
external variable, the external variable will be treated as an internal variable. In that case, no com-
munications for the variable will be performed with the connected device. You do not need to specify
this attribute for an internal variable.

@® Scaling

Specify a conversion expression to apply to the values of the connected device for external vari-
ables.

For information on setting the conversion expression, refer to 4-4-11 Registering Scaling on page
4-37.

® Comment Attribute

Enter a comment.
4-1-5 System-defined Variables

I System-defined Variables

System-defined variables are internal variables that are pre-defined by the system. All system-defined
variable attributes are fixed. The names and all other attributes of these variables are defined, and spe-
cial functions are assigned to them. You cannot change the names or any other attributes.

* You can use the system-defined variables for an HMI as soon as you register an HMI in the project. It
is not necessary to register system-defined variables in the global variable table.

» System-defined variables that are related to an HMI start with “_HMI_".

[l Expression |

#  MAMIlarmCount
_HMI_AarmsClearedMNotick
_HMI_AlsrmsNotAck
_HMI_AlfrmsRaized
_HMI_Al{rmsRaisedMotick
_HMI_Brifyhtness
_HMI_CajnEjectSDiCard
_HMI_CyrrentPage
_HMI_CfarrentUserMame
\HMI_{lurrentUserRole
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4 Creating the HMI Application

I System-defined Variables

® System-related Variables

Variable name Meaning Description :;a;: R/W
_HMI_Brightness Brightness Sets the brightness of the screen. Integer R/W
_HMI_CanEjectSDCard Can Eject SD Tells whether you can remove the SD | Boolean | R

Card Memory Card.
True: Ejection is possible, False: Ejec-
tion is not possible.
_HMI_ConnectedVNCClient | Connected num- | Gives number of client via VNC. Integer R
Count ber of VNC Client
_HMI_CurrentPage Current Page Sets the name of the currently dis- String R/W
Name played page.
_HMI_DateTime System Time Gives the system clock time as the Date- R
local time. Time
_HMI_Hour Current Hour Gives the hour in the current time. Integer R
_HMI_IsBatteryLow Low Battery Volt- | Gives True if the battery voltage has Boolean |R
age dropped below a specific level.
_HMI_IsDatalnput Data Entry in Gives True when a data entry objectis | Boolean |R
Progress selected.
_HMI_IsPageSwitching Page Switching in | Gives True while page switching pro- Boolean | R
Progress cessing is in progress and False after
processing is completed.
_HMI_IsScreenSaverActive | Screen Saver Sta- | Tells whether the screen saver is Boolean | R/W
tus active.
True: Active, False: Not active.
_HMI_ManagedRAMInUse | Usage of Man- Gives the total bytes of managed RAM | ULong R
aged RAM that is currently allocated to some pro-
cess.
_HMI_Millisecond Current Millisec- Gives the milliseconds in the current Integer R
onds time.
_HMI_Minute Current Minutes Gives the minutes in the current time. | Integer R
_HMI_RAMInUse Usage of RAM Gives the total bytes of RAM that is ULong R
currently allocated to some process.
_HMI_RAMTotal Total RAM Gives the total bytes of RAM that the ULong R
system is using or can use. This is not
the currently usable amount of RAM.
_HMI_RunSignal Run Signal Changes periodically while the HMl is | Boolean | R
operating.
_HMI_Second Current Seconds | Gives the seconds in the current time. | Integer R
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4 Creating the HMI Application

Variable name Meaning Description Itl;apt: R/W
_HMI_AlarmCount Alarm Count Gives the number of alarms that have | Integer R
occurred since startup.
_HMI_AlarmsClearedNotAck | Cleared Unac- Gives the number of alarms that are | Integer R
knowledged cleared but not acknowledged.
Alarms
_HMI_AlarmsNotAck Unacknowledged | Gives the number of alarms that are | Integer R a
Alarm Count not acknowledged. =
_HMI_AlarmsRaised Current Alarm Gives the number of current alarms. | Integer R ,‘;30
Count 7y
_HMI_AlarmsRaisedNotAck | Unacknowledged | Gives the number of current alarms Integer R %
Current Alarm that are not acknowledged. ’-°<
Count S
o
® User and Security G
Variable name Meaning Description It:;:at: R/W
_HMI_CurrentUserName Current User Gives the name of the user that is cur- | String R
Name rently logged in. AN
_HMI_CurrentUserRole Current User Gives the authority (role) of the user String R o
Authority that is currently logged in. %
2
I System Enumeration Variable Table §
[0]
The following table shows the enumeration variables that are used to control the HMI. ;%,
Enumerators are specified for input enumeration variables instead of numerical values. :g’
(2]
Data type name Description
_eHMI_BUZZER_TYPE Specifies the buzzer mode.
ContinuousBuzzer: Continuous buzzer
IntermittentLongPulse: Intermittent long buzzer
IntermittentShortPulse: Intermittent short buzzer
_eHMI_GRAPH_CURSOR Specifies the cursor for graphs.
Cursor1: Cursor 1
Cursor2: Cursor 2
_eHMI_GRAPH_DIRECTION Specifies the direction of graphs.
Left: Left
Right: Right
_eHMI_GRAPH_ZOOM_TARGET Specifies the expansion mode for graphs.
Both: Both
Horizontal: Horizontal direction only
Vertical: Vertical direction only
_eHMI_KNOWN_PATH Specifies the medium.
SDCard: SD card
USBMemory: USB memory
_eHMI_SERVICE_STATE Specifies the state of the service.
Running: Running
Suspended: Suspended
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Data type name Description
_eHMI_SERVICE_TYPE Specifies the type of the service.
VNCServer: VNC server
_eHMI_TROUBLESHOOTER_PAGE Specifies the screen displayed for the troubleshooter.

ActiveControllerEvents: Controller error list screen
ActiveUserEvents: User error list screen
ControllerEventLogs: Controller error log list screen
UserEventLogs: User error log list screen

_eHMI_VERTICAL_SCROLL_DIRECTION Specifies the direction of scrolling.

Downwards: Downwards

Upwards: Upwards

I System Structure Variable Table

The following table shows the structure variables that are used to control the HMI.

Data type name Variable Data type Description
_SsHMI_VNC_CLIENT_INFO Comment String Specifies a comment.
IPAddress String Specifies an IP address.
MACAddress String Specifies a MAC address.

4-1-6 Subroutine Variables

I Subroutine Variables

Subroutine variables can be used only with subroutines. Subroutine variables conform to Visual Basic
specifications.

Refer to the NA-series Subroutine Reference for details.
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4-2 Registering Data Types

® Registering Data Types
You can combine existing data types to define and register a new data type.

To use a data type that was registered with the Data Type Editor, just select it from the data types in
the Variable Editor. You can define data types that are structures or enumerations.

® Opening the Data Types Tab Page

1 Double-click Data Types under HMI - Data in the Multiview Explorer, or right-click Data Types
under HMI - Data and select Edit from the menu.

sadA] eyeq Bunieysibay z-v

The Data Type Editor is displayed.

Name Comment
Union
Enumerated

The basic operating procedures for the Data Type Editor are the same throughout the Sysmac Stu-
dio. For basic usage instructions, refer to the Sysmac Studio Version 1 Operation Manual (Cat. No.

W504). The differences are as follows:
* You cannot register unions.
* You cannot set the offset type, offset bytes, or offset bits.
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4-3 Creating Pages

One page represents one screen in the HMI project.
You can arrange various objects on a page to achieve the required functions.

There are two types of pages, as described in the following table.

Page Type in the Page Behavior Sizes (width and height) Application
Main Fixed for each model Basic pages

Pages can be layered.

You can specify a transparent color
and specify a background page.
Popup You can set the page sizes as long | Warning dialog boxes and other

as they are not larger than the main | applications

page size.

Main Pages Popup Pages

You can specify
any size that is

_ not larger than
The maximum the maximum
size is fixed. size.

You can specify any
size that is not larger
than the maximum size.

The maximum size is fixed.

® Main Pages

The main pages are the basic pages. You can create applications to call popup pages from main
pages or move to other main pages. You can place up to 450 objects on one main page. You cannot
place more than one Trend Graph, Broken-line Graph, or Media Player object on one page.

You can create layers of main pages.

You can specify a background page to make the top layer transparent and place a specified page
underneath it. You can layer up to five pages including the main pages.

You can create a common page, e.g., with a toolbar, to display with all other pages and then specify
it as the background page so that you do not have to create it more than once.

Main pages

Page 1: Transparent background

Page 2: Transparent background

Page 3: Background color
Page1 —»

Page2 —»

Page3 —»

® Popup Pages

Popup pages are called from main pages. Use them to display warnings and other information. You
can place up to 450 objects on one popup page. You cannot display more than one popup page at
the same time. Also you cannot place Trend Graph, Broken-line Graph, Tab Control, or Media
Player objects on a popup page.
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4 Creating the HMI Application

4-3-1 Displaying Pages

Click Pages under HMI in the Multiview Explorer.

¥ HMI
» [ Pages

The pages are displayed under Pages.

»
w
Q
8
4-3-2 Registering Pages 2
v
[
The project contains one page by default, and you can add more pages as required. ‘fg
I Registering New Pages
1 Right-click Pages under HMI and select Add - Page from the menu. IS
w
9
S
<
a
N
A new page, Page1, is added under Pages. ‘cfg

I Deleting Pages

1 Right-click the page to delete in the Multiview Explorer and select Delete from the menu.

A deletion confirmation dialog box is displayed.

Click the Yes Button. The page is deleted.
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I Copying and Pasting Pages

1 Select the page to copy in the Multiview Explorer and press the Ctrl + C Keys. Or, right-click the
page and select Copy from the menu.

The page is copied.

2 Select Pages in the Multiview Explorer and press the Ctrl + V Keys. Or, right-click Pages and
select Paste from the menu.

The copied page is registered with “Copy_1_of " added to the front of the name of the page that
was copied. All of the objects on the page are also copied.

@ Additional Information

* You can change the names of pages. Right-click the page and select Rename from the
menu.

* If you copy a page from another product and a page with the same name already exists, the
page will be named as a copy.
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4-3-3 Page Property Settings

You can set properties for the pages.

I Setting Properties

4 Creating the HMI Application

1 Right-click in a location in the Edit Pane where there is no object and select Properties.

2 Set the properties for the page in the Properties Window that is displayed.

Item classifi-
cation

Property

Description

Main pages

Popup pages

General

Name

Sets the name of the
page. All names must be
unique.

OK

OK

Type

The object type is dis-
played. Page is displayed
for a page.

Display only

Display only

Appearance

Background Color

Sets the background
color. A transparent page
will automatically be set if
a background page is
specified.

OK

OK

Behavior

PageType

Sets the type of page.

OK

OK

BackgroundPage

Sets a page that is over-
lapped as the back-
ground.

OK

AutoNavigateKeypads

If you select this check
box, the keypad is auto-
matically displayed
according to the Data
Input Order settings.

OK

OK

DisplayMode

If you select Modal, no
operations are possible on
the main page while a
popup page is displayed.
If you select Modeless,
main page operations are
possible while a popup
page is displayed.

OK

Moveable

If you select this check
box, the popup page can
be moved.

OK

CloseOnPageChange

If you select this check
box, the popup page is
automatically closed when
the page is changed.

OK
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4 Creating the HMI Application

Item cl_assm- Property Description Main pages Popup pages
cation
Layout Position (Let, Top) Sets the display position | --- OK

of the popup page. If you
select Custom, the coor-
dinates of the top left cor-
ner of the page are
specified with (Left, Top).

Size (Width, Height) Sets the size of the page. | Display only OK
The maximum size is the
physical size of the
screen.

OK: Can be edited, Display only: Cannot be edited, ---: Property does not exist.

Click the arrowhead (IEI) at the right of each item to make selections.

If you select a popup for the behavior setting, you can increase and decrease the width and

height layout sizes with the arrowheads on the right side of the box after first selecting the
size to change (left: width, right: height).

¥ Behavior

¥ Layout
L Size (Width,Height) 480, 240

4-3-4 Editing Pages

You can arrange objects on the pages to achieve the required functions.

I Positioning Objects

Drag objects from the Toolbox to position them on a page.
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4 Creating the HMI Application

I Moving Objects

To move an object, click the object and drag it while the cross cursor is displayed.

N

w

Q

I Resizing Objects =
«Q

v

Click one of the resize handles around the object and drag it while the resizing cursor is displayed. t§
(7]

+

@

S

g

E

n

&

]

I Rotating Objects

Click the rotation handle .~ to the upper right of the object and drag it while the angle is displayed in the
center of the object.

I Changing Object Labels

You can directly change the label of an object by selecting it and performing one of the following
operations.

* Press the F2 Key.

» Double-click the left mouse button.

* Right-click and select Edit.

+ Click the Edit Button on the Toolbar.
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The following objects are supported for this function:

 All the button objects including Buttons, Momentary Buttons, Set Buttons, Reset Buttons, and
Toggle Buttons

+ All the lamp objects including Bit Lamps and Data Lamps
» Label objects

+ Text Box objects

» Check Box objects

+ Radio Button objects

| Editing with the Toolbar

The functions that are commonly used to edit pages are provided in the Toolbar.

. Group

This button creates a group of objects.

. Ungroup

This button ungroups previously grouped objects.

B Eait

This button is used to edit graphic objects, labels of Button or Lamp objects, and other objects.

. Rotate Right 90 Degrees
This button rotates an object 90° clockwise.

. Rotate Left 90 Degrees
This button rotates an object 90° counterclockwise.

B Fiip vertical
This button flips a graphic object vertically.

B Fip Horizontal
This button flips a graphic object horizontally.

. Bring to Front
This button moves an object to the front.

. Bring Forward
This button moves an object toward the front.
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4 Creating the HMI Application

. Send Backward
This button moves an object toward the back.

. Send to Back
This button moves an object to the back.

. Align Left

This button aligns the left edges of the selected objects.

. Align Center Horizontal
This button aligns the centers of the selected objects vertically.

. Align Right
This button aligns the right edges of the selected objects.

. Align Top

This button aligns the top edges of the selected objects.

sabed Buneaiy ¢-p

. Align Center Vertical
This button aligns the centers of the selected objects horizontally.

. Align Bottom
This button aligns the bottom edges of the selected objects.

sebed Bunpa v-¢-v

. Distribute Horizontally
This button positions the centers of the objects at equal distances horizontally.

. Distribute Vertically
This button positions the centers of the objects at equal distances vertically.

ﬂ To Previous Tab Page
This button displays the previous tab page.

H To Next Tab Page
This button displays the next tab page.

E Data Input Order Setting

This button changes the mode to the one to set data input order, and specifies the input order of
objects.

Simulation Mode
This button changes the mode to the one to confirm object state.

Simulation Index

This button switches the index and lets you confirm the display state of objects.

English (United States) Change Language

This box changes the project language that is displayed in the Edit Pane.
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4-4 Setting Common Object Functions

This section describes the settings for functions that are shared by the entire HMI project.

The following functions are provided.

4-4-1

User alarms
Controller events
Data logging

Data groups
Recipes

Custom keypads
Global events
Global subroutines
Resources
Imported IAGs
Scale Transformations

Registering User Alarms

I User Alarms

You can specify conditions for specified variables to display user messages when the conditions are
met.

You can use this to record information when errors occur, when operation is started, etc.

I Registering a New User Alarm

You manage user alarms by group.

The groups are displayed in the User Alarms Viewer and are helpful in organizing information.

1 Right-click HMI under User Alarms in the Multiview Explorer and select Add - Group from the

menu.

Group1 is added under User Alarms.
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4 Creating the HMI Application

2 Double-click the new group.
A tab page to edit the group is displayed in the Edit Pane so that you can register user alarms.

suoioung 309[qo uowwon Bues v

@ Additional Information

You can copy the user alarm settings to Excel or another spreadsheet application to edit the
settings.

I Deleting, Copying, and Pasting Groups

You can delete, copy, and paste groups using the same procedures as those that you use for pages.

sjuaAg Jajjouo) Bumes z-i-

4-4-2 Setting Controller Events

I Events

Events are the errors, changes of states, or user-defined occurrences that occur in the controller.
For details, refer to the NJ-series CPU Unit Software User’s Manual (Cat. No. W501) and NJ-series
Troubleshooting Manual (Cat. No. W503).

I User Events

User event s include the errors and information defined by users, and can be triggered by com-
mands from the controller.

You can specify on the NA's NJ/NX-series troubleshooter, the user screens to be switched to from
the troubleshooter screen when a detailed user event of the controller is displayed.
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I Registering User Events

To switch a detailed user event screen of the troubleshooter to a user screen, you must specify the
event table for the controller and the transition destination screen that corresponds to each event.

1 Specify the event table of the user events in the project for the controller.

2 Double-click User Events under HMI - Controller Events in the Multiview Explorer of the proj-
ect for the HMI, or right-click User Events under HMI - Controller Events and select Edit from

the menu.

=1
HMI_NAS5_0 v HH

A Configurations and Setup
b4 HMI

» [ Pages

P2 Data Groups

The User Event Editor is displayed.

Controller:  |new Controller 0 v

Event Code | Event Name/Comment | Troubleshooter Associated Page
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3 Select the controller for which to perform the settings.
Select the target controller from the drop-down list at the top of the Edit Pane.

|l-

Controller: ' new_Controller_0

Event Code | Event Name/Comment | Troubleshooter Associated Page

4 Right-click on the grid and select Add from the menu.

|I-
Controller: |new_Controller_ 0 —

Event Code | Event Name/Comment | Troubleshooter Associated Page

suoioung 309[qo uowwon Bues v

5 Specify the event codes for the user events.
|b-
Controller: | new_Controller_0

Event Code | Event Name/Comment | Troubleshooter Associated Page

SjuaAg JajjojuoD Bumes z-i-v

6 Specify the user screens to use as the transition destinations.
'|b

Controller:  |new_Controller 0

Event Code | Event Name/Comment | Troubleshooter Associated Page

1

I Deleting, Copying, and Pasting User Events

You can delete, copy, and paste user events using the same procedures as those that you use for
pages.
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4-4-3 Registration for Data Logging

I Data Logging

You can use data logging to store the changes in the values of specified variables over time.
You can display the saved data with Trend Graph objects. You can also save this data to external files.

I Registering a New Data Set

To log data, you must create one or more data sets. You can create different data sets to change the
location where the data is saved.

1 Right-click HMI - Data Logging in the Multiview Explorer and select Add - Data Set from the
menu.

DataSet0 is added under Data Logging.

2 Double-click the new data set.

A tab page to make settings for the data set is displayed in the Edit Pane. You can set the vari-
ables to log, the storage locations, and other parameters.

@ Additional Information

You can copy the data set settings to Excel or another spreadsheet application to edit the set-
tings.
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I Deleting, Copying, and Pasting Data Sets

You can delete, copy, and paste data sets using the same procedures as those that you use for pages.
4-4-4 Registering Data Groups

I Data Groups

You can register the data groups that are displayed as broken-line graphs.

You can register multiple series of data as a data group. You can also register multiple variables or
array variables in each data series.

suoljaun 393lqo uowwos Bues -

I Registering a New Data Group

To display a block-line graph, you must create a data group. A maximum of 32 groups can be regis-
tered. You can specify up to 20 series of data for a single group.

1 Right-click HMI - Data Groups in the Multiview Explorer and select Add - Data Groups form
the menu.
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DataGroup0 is added under Data Groups.
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2 Double-click the new data group.

A tab page to perform settings for the data group is displayed in the Edit Pane. You can specify
variables to be displayed, as well ad other parameters.

Data Series Data Type Comment

Variable Data Type Comment

I Deleting, Copying, and Pasting Data Groups

You can delete, copy, and paste data groups using the same procedures as those that you use for
pages.

4-4-5 Registering Recipes

I Recipes

A recipe is used to write data (numeric data or text strings) that was set in advance in the HMI to all of
the specified variables as a group or to read all of the specified variables as a group.

You can manipulate the registered recipe data with Recipe Viewer objects.
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I Registering a New Recipe

To use recipes you must create them.

1 Right-click HMI - Recipe in the Multiview Explorer and select Add - Recipe Template from the
menu.

suoioung 309[qo uowwon Bues v

Recipe0 is added under Recipes.

2 Double-click the new Recipe0. A tab page to make settings for Recipe0 is displayed in the Edit
Pane. You can set the variables to use and other parameters.

Recipel X
Ingredient Name Variable ‘ Default Value | Min Value | Max Value | Visible ‘ Editablel

spedAay| woysn) Buusisibey 9-p-

@ Additional Information

You can copy the recipe settings to Excel or another spreadsheet application to edit the set-
tings.

I Deleting, Copying, and Pasting Recipes

You can delete, copy, and paste recipes using the same procedures as those that you use for pages.
4-4-6 Registering Custom Keypads

I Custom Keypads
You can specify the colors, layouts, and other properties of buttons to create keypads.

You can manage custom keypads by creating groups in which to register multiple keypads including
Boolean Keypad, Numeric Keypad, Hexadecimal Keypad, QWERTY Keypad, DataTime Keypad, and
TimeSpan Keypad.
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I Registering a New Custom Keypad

To create a custom keypad, you must first create a custom keypad group. You can register up to 50
groups.

1 Right-click HMI - Custom Keypads in the Multiview Explorer and select Add - Custom Keypad
Groups from the menu.

“Goup0” is added under Custom Keypads.

2 Right-click the new custom keypad group, and select Add and then select a custom keypad
from the menu.
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3 Double-click the new custom keypad.

A tab page to edit the custom keypad is displayed in the Edit Pane. You can set the layout,
design, and other parameters for the objects.

suoljaun 393lqo uowwos Bues -

I Applying a Custom Keypad

To use a custom keypad, you must specify the custom keypad group to use on the Language Settings
Tab Page.

1 Double-click Language Settings under Configuration and Setup in the Multiview Explorer.

2 Select a custom keypad group from the drop-down list of the Software Keypads in the Edit
Pane.
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Deleting, Copying, and Pasting Custom Keypads or Custom Keypad
Groups

You can delete, copy, and paste custom keypads or custom keypad groups using the same procedures
as those that you use for pages.

4-4-7 Setting Global Events and Corresponding Actions

I Global Events

Global events occur at the project level and do not belong to any specific page.

When a global event occurs, the action that is assigned to the event is executed.

® Global Events
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Global events include function key operations, changes in the values of variables, starting the proj-
ect, etc. A list of the events that you can set is provided in A-71 Events and Actions on page A-2.

® Actions

You can specify the action to perform when a global event occurs from a list of predefined actions.
Actions include executing global subroutines and other system-defined operations. A list of the
actions that you can set is provided in A-1 Events and Actions on page A-2.

I Setting Up Global Events

To set up a global event, you select the global event and then set the action to execute when the event
occurs.

1 Right-click HMI - Global Events in the Multiview Explorer and select Edit from the menu. Or,
double-click HMI - Global Events.

2 A tab page to make settings for the global event is displayed in the Edit Pane.

< Select Event to Add > -

3 Click in the column on the right to select the event to set from the event list.

< Select Event to Add >

FlKeyRelease
F2KeyPress
F2KeyClick
F2KeyRelease
F3KeyPress
F3KeyClick
F3KeyRelease
Interval
ProjectInitialization

A global event is added.

< Select Event to Add > -

=

] FlKeyPress
=]

< Select Action to Add > -
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4 In the Actions row below the new global event, click in the right column and select the action to
perform for the event from the action list.
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5 When you add global events, they are numbered serially from 0 in the order that you add them.

I Deleting Global Events

To delete all of the settings for global events, right-click the Events header at the top and select Reset.

To delete an individual event, click the Button on the right edge of the event.

suonoy Bulpuodssa.lon pue sjusag [eqols) bumes /-v-
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4-4-8 Registering Global Subroutines

I Global Subroutines

You can register global subroutines, which you can then call from anywhere in the project.

You can register common subroutines that do not rely on page conditions to make subroutines easier to
maintain.

I Registering a New Subroutine Group

To register global subroutines, you must create one or more subroutine groups. You can use subroutine
groups to separate subroutines by purpose.

1 Right-click HMI - Global Subroutines in the Multiview Explorer and select Add -Group from
the menu.

SubroutineGroup1 is added under Subroutine Groups.

2 Double-click the new subroutine group. A tab page for the Code Editor is displayed in the Edit

Pane.

SubroutineGroupl X

B [ v]
1! 'Add global subroutines B

2}

I Deleting, Copying, and Pasting Subroutine Groups

You can delete, copy, and paste subroutine groups using the same procedures as those that you use
for pages.
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4-4-9 Setting Up Resources

I Resources

Resources are the text strings, movies, still images, and documents that are displayed for objects and
alarms on user pages.

You can use Resources to manage all of the text strings, images, files, and other resources that you
use in a project.

For multi-language projects, you can set resources for each project language.

I Setting Up Resources

To set up a resource, select the resource to set up and then make the settings.
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1 Right-click HMI - Resources - Root in the Multiview Explorer and select Edit from the menu.
Or, double-click HMI - Resources - Root.
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2 A tab page to make settings for resources is displayed in the Edit Pane. You can select the
resource to set and make the settings.
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4-4-10 Setting Up IAG Resources

I IAG Resources

IAG resources are used within IAGs on user pages. When you place an IAG on a page, the resources
for the IAG are automatically registered.

The languages that are displayed by the IAG resources are determined by the project languages. The
resources that are set in advance for the IAGs are displayed for the IAG resources. If a language that is
not included in an IAG is set as a project language, the resources will be blank by default.

I Setting Up Resources

To set up an IAG resource, select the IAG resource to set up and then make the settings.

1 Right-click the IAG resource to edit under HMI - IAG Resources in the Multiview Explorer and
select Edit from the menu. Or, double-click the IAG resource.

2 A tab page to make settings for IAG resources is displayed in the Edit Pane. The procedures
are the same as for other resources, but you can change only the contents of the resources that
are in the IAGs.
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4-4-11 Registering Scaling

I Scaling
Scaling is used to transform displayed numeric values by specifying a multiplier and offset value.

To perform the settings for each object, open the object properties and set the parameters for scaling
under Behavior.

You can perform the settings for individual variables on the Global Variables Table.

Example: In this example, a multiplier of 100 and an offset of 50 are specified for an integer variable

suoioung 309[qo uowwon Bues v

(intSample):
Value of intSample Calculation formula Displayed value
0 50+0%100 50
1 50+1%x100 150
2 50+2x100 250
100 50+100%100 10050

I Registering a New Scaling

You c an register a maximum of 1,000 scaling settings.

1 Right-click HMI - Scale Transformations in the Multiview Explorer, and select Edit from the
menu. Or, double-click HMI - Scale Transformations.

Buieog Buuelsibey |-

2 A tab page to perform settings for the scaling is displayed in the Edit Pane.

Scale Transformations X

Scale Name | Multiplier | Offset | Comment

3 Right-click in the grid and select Add from the menu.
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4 Specify the scale name, multiplier, offset, and other items.

I Deleting, Copying, and Pasting Scalings

To delete all of the settings for scaling, select all the items and then right-click and select Delete from
the menu.

To delete an individual scaling, click the button at the bottom left of the setting pane.

El Precautions for Correct Use

When rounding values to the nearest integer, ".5" is rounded to the nearest even-number inte-
ger, as shown in the following examples.

Value before rounding Value after rounding
1.2 1
1.5 2
1.8 2
25 2 (not 3)
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4-5 Subroutines

I Subroutines

Subroutines are Visual Basic programs that the user can create. You create subroutines under Subrou-
tines in the HMI project.

|E| Precautions for Correct Use

This manual describes only aspects that are different from the specifications standardized by
Microsoft Corporation. For any specifications not given in this manual, refer to commercially
available reference materials.

saunnoiqng G-

I Subroutines

There are global subroutines and page subroutines, as described below.

® Global Subroutines
Global subroutines are shared by the entire project.

You create global subroutines under Global Subroutines in the HMI project. You set CallSubroutine
as the action in a global event, object event, or user alarms event to call a global subroutine.

You can also call a global subroutine from a page subroutine or from another global subroutine.

® Page Subroutines
Page subroutines are specific to one page.
You create page subroutines with the Code Editor for a page in the HMI project.
You can directly create the subroutines to execute in the events for individual objects on pages.
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4-5-1 Subroutine Execution

You can execute subroutines in the following ways.
» Execution from Global Events
You can execute a global subroutine from a global event.
» Execution from Page and Object Events
You can execute a page subroutine or global subroutine from a page or object event.
+ Execution from User Alarm Events
You can execute a global subroutine from a user alarm event.

I Execution from Global Events

The following example shows how to use a global event to execute a global subroutine.
In this example, settings are made to execute the global subroutine when the F1 Key is pressed.

1 Display the global events and select F1KeyPress as the event.

2 Select CallSubroutine as the action.

3 For the subroutine name, specify the name of a previously created subroutine in the following
format: Subroutine_group.Subroutine_name
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I Execution from Objects

The following example shows how to use an object event to execute a subroutine.

In this example, settings are made to execute the subroutine when a Button object is pressed.

1 Select the Button object and display the events and actions.

saunnouqng G-

2 Select Click as the event.

uonnNoax3 aunnoIaNs |-G-
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3 Select CallSubroutine as the action.

4 Specify the subroutine to execute in the following format: Subroutine _group.Subroutine_name
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I Execution from User Alarms

The following example shows how to use a user alarm event to execute a subroutine.

In this example, settings are made to execute the subroutine when the user alarm occurs.

1 Select the user alarm and display the events and actions.
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2 Select Raised as the event.
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3 Select CallSubroutine as the action.

NA-series Programmable Terminal Software User’s Manual (V118) 4-43



4 Creating the HMI Application

4 Specify the subroutine to execute in the following format: Subroutine_group.Subroutine_name

4-5-2 Precautions on Internal Processing

® Handling of Variables

If the value of an external variable is changed in a subroutine, the change is immediately updated at
the connected device. Therefore, if you frequently change the value of an external variable inside a
subroutine, the performance of that subroutine will be reduced.

® Processing during Subroutine Execution

The touch panel and function keys will not respond during execution of a page subroutine. If you
execute processing that requires time, the HMI will not perform other operations until the processing
is completed. Consider the execution time when you create subroutines. However, processing will
continue for background operations, such as communications, and for page refreshing.

® Simultaneous Execution of Subroutines

It is possible that a subroutine for a global event and a page subroutine will be executed simultane-
ously. If both subroutines manipulate the same variable, implement exclusive control or other suit-
able measures.

I Background Processing of Subroutines for Global Events

If you select the AsyncExecution Check Box, a subroutine process and a drawing update process
for that global event are asynchronously executed. Up to five subroutines can be executed simulta-
neously. If you attempt to execute more than that, the processes enter standby for execution. If the
number of subroutines waiting for execution exceeds 100, a warning dialog box appears on the
screen.

When you asynchronously execute subroutines, the execution timing is controlled by the OS. There-
fore, if you do not synchronize subroutines, you may get unexpected results.

Start actual system application only after sufficiently checking the timing of the execution of the oper-
ations of the programs.
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4-5-3 Code Editor

Subroutines are edited with the Code Editor.

I Starting the Code Editor

® Global Subroutines

Double-click a previously registered subroutine under HMI - Global Subroutines in the Multiview
Explorer. Or, right-click the subroutine and select Edit from the menu.

® Page Subroutines

Right-click a previously registered page name under HMI - Pages in the Multiview Explorer and
select Code Editor from the menu.

saunnoiqng G-

I Code Editor Features

The Code Editor provides functions equivalent to those of a standard text editor. It also provides func-
tions that are optimized for Visual Basic, such as keyword highlighting, entry assistance, and collapsing
Sub statements.

4-5-4 Differences in Language Specifications

Joyp3 8poy €-G-¥

Although subroutines are used in Visual Basic, some of the functions are restricted for HMIs. There are
also extensions that are provided for use with HMIs. Refer to the NA-series Subroutine Reference for

details.
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4-6 Search and Replace

You can search and replace strings in the data of an HMI project. The basic Sysmac Studio operations

for searching and replacing generally apply to HMIs. Refer to the Sysmac Studio Version 1 Operation
Manual (Cat. No. W504) for details.

I Differences When an HMI Is Selected

The following differences apply when an HMI is selected.
* You can select only All for the Look at Box.

|E| Precautions for Correct Use

You can use an action name as a search string, but you cannot replace it with another action
name.

Example: You can search for the objects that specify the Login action. However, you cannot

replace the Login action settings with the Logout action settings using the replacement func-
tion.
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4-7 Cross References

4-7-1 Cross References

Cross references allow you to confirm in a list format where an element ! that is part of a project is used
within the project.
On the list that shows the locations where an element is used, you can access the locations where the

element is used. »
*1. You can cross-reference the following elements. ;
+ Variables S
7]
+ Data types 2
 Pages §
* Resources 2
(7]

The basic operating procedures are the same as for the rest of the Sysmac Studio. Refer to the Sysmac

Studio Version 1 Operation Manual (Cat. No. W504) for details.

I Displaying and Manipulating Cross References "
X
1 From the main menu, select View - Cross Reference Tab Page. g
The Cross Reference Tab Page is displayed. You can check a list of the locations where the %
selected element is used. oy
(]
3
[]

NA-series Programmable Terminal Software User’s Manual (V118) 4 -47



4 Creating the HMI Application

4-8 Building

4-8-1 Building

The project must be built to convert it into a form that the HMI can execute.
During the building process, subroutines and variables are checked.

If there are any errors, the build operation is not performed and is displayed next to the program or
variable where the error occurred in the Multiview Explorer.

You can confirm the errors on the Build Tab Page.

4-8-2 Build Operation

Use the main menu to execute the build operation. HMI projects are not built automatically even if no
operations are performed for 5 seconds.

I Executing a Build Operation

1 Select Build HMI from the Project Menu.

I Aborting a Build Operation

No functions can be executed while building the project is in progress. If necessary, you can abort build-
ing to check the project.

1 Select Abort Build from the Project Menu.

2 The build operation is aborted and a message that says it was aborted is displayed in the Out-
put Tab Page.
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4-9 Offline Comparison

HMI projects are not included in offline comparisons. Even if you perform an offline comparison for a
project that contains an HMI as a device, information on the HMI is not included in the comparison

results.

uosuedwo) aullyo 6-v
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This section describes the objects that are provided as standard features.

5-1 Objects ......ciiiiii i i i e et e 5-2
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5-1-2  Object Attributes . . ... ... 5-4
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5-2-3 DisplayingaTrend Graph .. ....... ... .. . i 5-16
5-2-5 UsingaRecipe . ...... .. 5-21
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5-2-7 Displaying Text Strings by Indirect Addressing . ....................... 5-27
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5-1 Objects

Basic objects are provided in the Sysmac Studio as standard features. You can use these objects to
easily create pages.

5-1-1 Object List

The following objects are provided.

I Functional Objects

A functional object provides some sort of function by itself.

Classification Object name Description

Buttons Button object Used to execute an action without writing a value to a variable.
Momentary Button Used to change the value of the specified variable to True only while
object the object is being touched.
Set Button object Used to change the value of the specified variable to True when the

object is touched.

Reset Button object Used to change the value of the specified variable to False when the
object is touched.

Toggle Button object | Used to toggle the value of the specified variable between True and
False when the object is touched.

Lamps Bit Lamp object Lit while the result of the condition expression is True.

Data Lamp object Used to change the color of the lamp according to the value of a condi-
tion expression.
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Classification

Object name

Description

Standard con-
trols

CheckBox object

Used to change a variable to True or False depending on whether the
check box is selected. Also, the check box can be displayed when the
value of the specified variable changes.

Data Display object

Used to display numeric values or text strings.

Data Edit object

Used to display and enter numeric values or text strings.

DateTime object

Used to display the value of a variable as a date and time.

DropDown object

Used to store the value that corresponds to the item selected in a
drop-down list in a variable. Also, the item that corresponds to the
specified variable value is displayed.

Image object

Used to display an image. Refer to A-2 Supported Formats on page
A-5 for the supported formats.

Label object

Used to display a fixed text string. Also, if you use DisplayValue for the
animation property, you can display the value of the variable.

ListBox object

Used to store the value that corresponds to the item selected in a listin
a variable. Also, if the value of the specified variable is changed, you
can move the focus to an item that corresponds to the new value of the
variable.

Radio Button object

Used to set the specified variable to the value that was set for the
selected button. Only one of the specified group of buttons can be
selected. Also, the option button can be displayed when the value of
the specified variable changes.

s303lqo L-§

Slider object

Used to set the specified variable to the value that corresponds to the
position of the slider. Also, if the value of the specified variable is
changed, you can move the slider to the position that corresponds to
the new value.

Tab Control object

Used to partially change pages within the screen. Several tab pages
are used to change the displayed contents by changing the tab page.
You can create a maximum of 64 tab pages for a Tab Control object,
and up to 10 Tab Control objects on a screen.

TextBox object

1817108[90 L-L-G

Used to display a fixed text string. A TextBox object differs from a Label
object in that the text string in a TextBox object will wrap.

Gauges Gauge Object There are several types of gauges provided, such as one with a needle
that rotates in a circle and one with a needle that moves in a straight
line.

HMI controls Broken-line Graph Used to display broken-line graphs.

object

Media Player object

Used to create an object that plays video. Refer to A-2 Supported For-
mats on page A-5 for the supported formats.

Recipe Viewer object

Used to display the contents of a recipe.

Trend Graph object

Used to display data from data logging as a graph.

User Alarms Viewer
object

Used to display a user alarm.
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I Graphic Objects

A graphic object does not provide any specific function by itself. You must add functions by using
events and actions. Many different graphic objects are available. Some typical ones are described in
the following table.

Classification

Object name

Description

Shapes

Curve object

Used to draw a curved line. You can double-click the graphic object to
edit it.

Ellipse object

Used to draw a circle or ellipse.

Line object

Used to draw a straight line. You can double-click the graphic object to
edit it.

Polygon object

Used to draw a polygon. You can double-click the graphic object to edit
it.

Polyline object

Used to draw connected straight lines. You can double-click the
graphic object to edit it.

Rectangle object

Used to draw a rectangle.

Triangle object

Used to draw a triangle. You can double-click the graphic object to edit
it.

5-1-2 Object Attributes

There are the following three types of attributes for objects.

* Properties
* Animations

« Events and actions

Objects

D —+— Animations

—— Events and actions

— Properties

---- These are static attributes.

--- These attributes control object animations when the specified

condition expressions are met.

---- You can specify events and the actions to perform

when the events occur.
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5 Objects

® Properties

Properties are the static attributes of an object.

These include settings for the names and other general properties, colors, positioning, and other
display properties, and assigned condition expressions or variables, as described in the following

table.
Properties
Properties Description
General You can set the name of the object and check the object type.
Appearance You can set the object color, shape, label, etc.
Behavior You can set condition expressions, variables, and delay times to assign to
the object.
Expression You can specify a condition expression that uses variables.
Variable You can specify a variable.

IsEnabled, DoubleTouch-
Time, OnDelayTime, etc.

You can make settings to enable the object, determine the double-touch
interval, set the ON-delay time, etc.

Layout You can set the position and size of the object.
Security You can set security for the object.

Pointer Marker You can set the needle marker for a gauge.

Ranges You can set the range for a gauge.

Scale Bar You can set the scale bars for a gauge.

Tick Label You can set scale labels for a gauge.

Tick Major You can set the major scale division labels for a gauge.
Tick Minor You can set the minor scale division labels for a gauge.
Needle You can set the needle for a gauge.

Needle Cap You can set the needle cap for a gauge.

Data You can set the display target of a Trend Graph or Broken-line Graph.
Left Axis You can set the left axis for a graph.

Right Axis You can set the right axis for a graph.

Time Scale You can set the time axis for a graph.
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® Notation for Expression

If you specify a BOOL variable, e.g., for a Lamp object, you can specify an expression for the
Behavior property.

Examples of the expression notations are given below.

Example 1: Executing a Function when a Boolean Variable (biInSample in this Example) Is True

biInSample=True

Example 2: Executing a Function when an Integer Variable (intSample in this Example) Is Less
Than 20

intSample<20

Example 3: Executing a Function when a Boolean Variable (b/nSample in this Example) Is True and
an Integer Variable (intSample in this Example) Is Less Than 20.

(bInSample=True) AND (intSample<20)

Example 4: Setting a Value by Adding 100 to an Integer Variable (intSample in this Example)
intSample+100

Notation for CustomDisplayFormat

If you set DisplayFormat to Custom for a Data Display object, you must set the custom display for-
mat (CustomDisplayFormat). The basic format is 0:*****, where ***** is replaced with the result of
Expression.

This format follows the specifications of custom numeric format strings in Visual Basic. For details,
refer to the Microsoft website or to commercially available reference materials.

Example 1: Display When Result of Expression is 1.234 and {0:00.0000} Is Specified
01.2340

Example 2: Display When Result of Expression is 1.234 and {0:##.####} |s Specified
1.234

Example 3: Display When Result of Expression is 1.234 and X={0:##.####} Is Specified
X=1.234
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5 Objects

® Animations

You can use animations to change the status of the object according to Expression (condition

expression).

As described below, you can specify the status when the condition expression is met, such as flash-
ing, enabling/disabling operation, size/coordinate changes, and displaying/hiding the object.

Animation List

Animation name

Description

Blink

When the condition expression is met, the object flashes in the specified color.

ColorChange(Analog) Changes the color of the object according to a value.

ColorChange(Boolean) Changes the color of the object according to True/False status.

DisplayValue Displays a value based on a condition expression.

Enable Enables operating the object when the condition expression is met.

Move Changes the coordinates of the object according to specified condition expres-
sions.

PercentageFill Fills a graphic figure based on a condition expression and a percentage
between the upper and lower limits.

ResizeHeight Changes the height of the object according to a specified condition expression.

ResizeWidth Changes the width of the object according to a specified condition expression.

Rotate Rotates a graphic object based on a condition expression.

Visibility Displays the object when a condition expression is met.

I Events and Actions

® Events and Actions
You can make settings for object events and corresponding actions.

You can specify events and the actions to perform when the events occur.

You can specify the required conditions and operations, such as executing a specified subroutine
when a function key is touched.

The events and actions are listed in A-1 Events and Actions on page A-2.
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5-1-3 Using Objects

The objects are provided in the Toolbox on the right side of the window.

You can create them on pages and set the properties and animations and also the events and actions.

I Creating Objects

1 Drag the objects from the Toolbox and drop them on the page.
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I Setting Properties

1 Double-click the object.

@ Additional Information

You can also use the following methods to display the properties.
» Select Properties from the View Menu.
» Right-click the object and select Properties from menu.

2 The properties are the static attributes of the objects.

s303lqo L-§
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Make the following settings as required.

I Setting Animations

1 Select Animations from the View Menu.

2 You can set the animations of the objects in the Animations Window.
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I Setting Events and Actions

1 Select Events and Actions from the View Menu.

s303lqo L-§

2 You can set the actions for events in the Events and Actions Window.

sp8lqo Buisn ¢-1-G
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5-2 Examples of Using Objects

This section provides examples of using objects.

5-2-1 Displaying a PDF File
The following example shows how to display a PDF file full screen when a button is touched.

1 Place a button on the page.

2 Select Events and Actions from the View Menu.

3 Select Click from Events.

5-12 NA-series Programmable Terminal Software User’s Manual (V118)



5 Objects

4 Select ShowDocument (FullScreen) from Actions.

s)oalqQ Buisn jo sajdwex3y z-g

5 Set DocumentFileName to the name of the file to display.

Events and Actions
Button0

¥ Events
¥ [0

¥ Actions < Select Action to Add >

¥ [0] ShowDocument o

ld CDocumentFilename | sample.pdf '|£|
Transfer the project to the HMI and confirm the operation.
The PDF file should be displayed when the button is touched.

alld 4ad e Buikeidsig 1-z-G
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5-2-2 Displaying a User Alarm

The following example shows how to register a user alarm and display a message when the user alarm
occurs.

This example creates a user alarm that displays the message Alarm1 in a confirmation dialog box when
the binAlarm1 variable changes to True.

1 Double-click Group0 under HMI — User Alarms in the Multiview Explorer.

2 Right-click in the user alarm table for the new group and select Add from the menu.

3 A row is added. Make the following settings in the new row. Use the default values for settings
that are not specified.

Name: UserAlarm1
Expression: binAlarm1=True
Message: Alarm1

Popup: Selected
Acknowledge: Selected

@ Additional Information

If you set a page name for the Page parameter, the screen is switched to the specified page
when an alarm occurs. Select an alarm displayed on the User Alarms Viewer, and execute the
ShowAlarmPage action/function. The screen is changed to the specified page.
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4 Double-click HMI - Pages - PageO0 in the Multiview Explorer. Drag a User Alarms Viewer object
from HMI Controls in the Toolbox to the page.

s)0alqo Buisn jo sajdwexy z-g

Transfer the project to the HMI and confirm the operation.

When the blnAlarm1 variable changes to True, the contents that was set for the User Alarms
Viewer object are displayed in a confirmation dialog box.

wuely Jesn e buike|dsiq z-z-S
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5-2-3 Displaying a Trend Graph

The following example shows how to register a data set for data logging and display a trend graph that
accesses it.

This example records log data continuously every 5 seconds and saves it in a separate file for each
24-hour period.

1 Register an integer variable called intDatalog1 in the global variable table.

2 Right-click HMI - Data Logging in the Multiview Explorer and select Add - Data Set from the
menu.

3 Double-click the new data set.

4 Right-click in the new data set grid and select Add from the menu.

r

Add

5 A row is added. Set intDatalog1 in the Variable column of the new row. Use the default values
for other settings.
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6 Double-click Page0 under HMI - Pages in the Multiview Explorer. Drag a Trend Graph object
from HMI Controls in the Toolbox to the page.

s)oalqQ Buisn jo sajdwex3y z-g

7 Set the name of the data set that you created as the data set in the properties.
¥ Data

AnalogTraces

DigitalTraces

8 Click the for Analog Traces and set the variable to display on the graph.

Set intDatalog1 as the variable.

¥ Data

ydeus) puai] e Buihe|dsiq g-z-

DataSet DataSetD
¥ AnalogTraces gl +
¥ [0] analogTracel: @
WETL T analogTrace(
intDatalog
et It= | eft Scale -

Color

. DarkOrchic

MENCIAN Mone A
DigitalTraces g +

Insert an SD Memory Card into the HMI, transfer the project to the HMI, and confirm the opera-
tion.
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Every 5 seconds, the value of intDatalog1 should be sampled and displayed on the graph.

5-2-4 Displaying a Broken-line Graph

The following example shows how to use a broken-line graph.
1 Register an integer array variable called intData(10) in the global variable table.

2 Right-click HMI - Data Groups in the Multiview Explorer and select Add - Data Groups from
the menu.

3 Double-click the new data group.

4 Register a data series in the new DataGroup0.
Right-click in the grid and select Add form the menu.
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5 A row is added. Perform the following settings in the new row. Use the default values for all
other settings.

6 Set an array variable called intData in the added data series. Use the default values for all other
settings.

s)0alqo Buisn jo sajdwexy z-g

7 Go back to the Page Edit Pane. Double-click Page0 under HMI - Pages in the Multiview
Explorer. Drag a Broken-line Graph object to the page from HMI Controls in the Toolbox.

ydels suij-uayoig e buikeidsiq -z-S
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8 Set the name of the data group that you created as the data group in the properties.
¥ Data

DataGroup DataGroup0
Offset 0

Traces 0 +

9 Click the for Traces and set the variable to display on the graph.
Set TestDataSeries1 in DataSeries.

Transfer the project to the HMI, and confirm the operation.

The value of each element of intData(10) should be displayed on the broken-line graph.

Broken Line Graph
100.00 100.00

75.00 75.00

50.00 50.00

25.00 25.00

0.00 0.00
0.00 10.00 20.00 30.00 40.00 50.00
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5-2-5 Using a Recipe
The following example shows how to use a recipe.
1 Register integer variables called intRecipe1 and intRecipe2 in the global variable table.

2 Right-click HMI - Recipes in the Multiview Explorer and select Add - Recipe Template from the
menu.

3 Double-click the new recipe template.

s)oalqQ Buisn jo sajdwex3y z-g

adioay e buisn G-z-G

4 Register ingredients in the recipe template for the new recipe, RecipeO.
Right-click in the grid and select Add from the menu.

Show Recipes

@ Additional Information

A recipe template is a defined data structure for a recipe.
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5 A row is added. Make the following settings in the new row. Use the default values for other set-
tings.

Ingredient Name: Recipe1
Variable: intRecipe1
Default Value: 10

Min Value: 0

Max Value: 100

Set Recipe?2 as follows:
Ingredient Name: Recipe2
Variable: intRecipe2
Default Value: 20

Min Value: 0

Max Value: 100

Ingredient Name Variable Default Value Min Value Max Value Visible | Editable

intRecipel 10 0 100 ¥ 4
intRecipe? 20 0 100 ] [+

6 Right-click in the grid and select Show Recipes from the menu.

Add
Delete

Move Up

7 Right-click in the grid and select Add from the menu.

Show Ingredients

@ Additional Information

Recipes make settings in advance that are actually set according to the data structure.
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8 A row is added. Make the following settings in the new row. Use the default values for other set-
tings.

Recipe Name: RecipeSample1
Recipe1: 30
Recipe2: 40

Recipe Name: RecipeSample2
Recipe1: 50
Recipe2: 60

-ngcipeo x =

Recipe Name | Recipel | Recipe2 |

RecipeSamplel 30 40

9 Create a button to transfer the recipe.
Right-click HMI - Pages- Page0 in the Multiview Explorer and select View Code from the menu.

s)oalqQ Buisn jo sajdwex3y z-g

10 Create the following subroutine.

adioay e buisn G-z-G
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11 Double-click HMI - Pages - Page0 in the Multiview Explorer. Drag a Recipe Viewer object from
HMI Controls in the Toolbox to the page.

12 Then drag a Button object from Buttons in the Toolbox to the page and set the following event
and action.

Events and Actions
Button0

¥ Events < Select Event to Add =
¥ [0] Click ]

¥ Actions < Select Action to Add » v

¥ [0 CallSubroutine (]

SubroutineMame| WriteSubroutine

Transfer the project to the HMI and confirm the operation.

When the button is touched, the values that are set for the specified recipe should be written to
the connected device.
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5-2-6 Setting the Order of Automatic Move of Input Focus

The following example shows how to consecutively enter numeric values in the multiple data input
objects placed on a page.

1 Register an integer variable called intData1 in the global variable table.

2 Place a data input object on the page.

s)oalqQ Buisn jo sajdwex3y z-g

3 Set intData1 in Variable of the properties for the data input object.
¥ Behavior
IsEnabled

DataType Mumeric

intDatal

4 Place the multiple data input objects on the page by copying and pasting one.
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5 Click the Data Input Order Setting Button on the Toolbar to switch to the mode for setting data
input order.

6 Click the data input objects in the order in which to move the input focus.

7 When you complete the settings, the following dialog box appears.

Data Input Order

All objects have now been assigned a data input order value.

8 Select the AutoNavigateKeypads Check Box under Behavior in the properties of the page.
¥ Behavior
Pagelype

BackgroundPage

Transfer the project to the HMI, and confirm the operation.

When you press a data input object, a keypad is displayed. After you complete an input, the
input focus is automatically moved from one data input object to the next.
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5-2-7 Displaying Text Strings by Indirect Addressing

You can dynamically change text strings that are displayed on label objects or text box objects. The fol-
lowing example shows how to switch a text string displayed on an object by using a value specified in a
variable.

1 Register an integer variable called intData1 in the global variable table.

2 Register a new resource group in a Resources table.

s)0alqo Buisn jo sajdwexy z-g

3 Open the added Resources table, and register a text string to display on an object.
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4 Open the Page Editor and create a Label object.

5 Open the properties of the Label object, and set Link Type to Dynamic under Appearance -
Text (Default) - Resource.

¥ Appearance

¥ Text (Default)

Resource Link Type | Dynamic

Expression

Set “Group0_String” & intData1 in Expression.

N O

On the page, create the data input object that inputs values to intData1.
Transfer the project to the HMI and confirm the operation.

When the value in intData1 is O, the Label object displays “ABC”.
When the intData1 value is changed to 1, the object displays “XYZ”.

@ Additional Information

In Expression, set the text string that is displayed for the Resource ID on the Resources table.
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This section describes how to go online with an HMI.

6-1 Introduction . ........... ...ttt e 6-2
6-2 Going OnlinewithanHMI .............. ... . . . i, 6-3
6-2-1  Methods for Going Online withan HMI ... ........ .. ... ... ... .. ... .... 6-3
6-2-2  Setting the Connection Method . ........ .. ... .. ... ... ... ... ... .. ... 6-4
6-2-3 Online Connection .. ... ... .. e 6-5
6-2-4  Going Online after Checking the Connection Method . .. ................. 6-6
6-2-5 Going Offline . . ... ... e 6-6
6-2-6 Confirming Serial IDs . . ... ... ... 6-7
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6 Connecting to the HMI

6-1

Introduction

I Connecting to the HMI

You must go online with the HMI or connect to the Simulator to communicate with it from the Sysmac

Studio.

The Sysmac Studio supports the following online connections for different applications.

Online connection

Connection made to

Application

Online connection

The actual HMI

To perform debugging, startup, or normal maintenance, the
same project as in the actual HMI is opened on the Sysmac
Studio and then an online connection is made. An online con-
nection is made based on the Communications Setup in the
project.

Simulator connection

HMI Simulator

The Simulator is used to debug the program offline. The Com-
munications Setup in the project is not used.

@ Additional Information

Refer to 7-1-4 Offline Debugging with Only the HMI Simulator on page 7-6 for information on
connecting to the Simulator and debugging operations.
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6-2 Going Online with an HMI

You can simultaneously go online with more than one HMI in a project from the Sysmac Studio. The
operations that are described in this section apply to the currently selected HMI. If there is more than
one HMI registered in the project, confirm the HMI to operate before connecting to it.

|E| Precautions for Correct Use

Do not reconnect the USB cable for at least 10 seconds after you disconnect it. After you con-
nect the USB cable, do not disconnect it until Windows detects the connection.

It may become impossible for Windows to detect when the cable is connected or disconnected,
which would effectively disable the USB port. If that occurs, restart the computer. Otherwise,
you will not be able to use the USB device until Windows recovers from the suspended status.

@

N

@

=)

a

6-2-1 Methods for Going Online with an HMI S

=]

(]

To go online with an HMI, there are three connection methods that can be used. These are described in =

the following table. =

=]

Connection method Connection diagram Description %

Direct connection via The USB port on the computer is

USB connected directly to the USB slave

port on the HMI.
This is the default connection con-

figuration.
Direct connection via The Ethernet port on the computer
Ethernet is connected directly to Ethernet

port 2 on the HMI.

Ethernet connection The Ethernet port on the computer

via hub is connected through the Ethernet
network to an Ethernet port on the
HMI.

IINH UE y)im sulu BuloD 1oy SPOUIBIN L-2-9
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6 Connecting to the HMI

6-2-2 Setting the Connection Method

You must set the connection method, IP address to connect to, and other parameters for communica-
tions between the computer and HMI.

1 Select Communications Setup from the HMI Menu.
The Communications Setup Dialog Box is displayed.

2 Select the connection method for the connection configuration in the Connection Type Field.

For an Ethernet connection via a hub, enter the IP address of the HMI to which you need to con-
nect in the Remote IP Address Area. Select any required options and enter the communications
time-out time if required.

Note Refer to Communications Setup Dialog Box Settings on page 6-5 on the next page for information on
the settings.

3  Click the OK Button.

This concludes the settings.
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® Communications Setup Dialog Box Settings

Item Description
Connection Type Select the connection port to use to go online.

The selected method is normally used to go online.
Remote IP Address If you specify an Ethernet hub connection, set the IP address of the HMI that you will
connect to. Also, you can click a test button to perform a communications test.

Test USB Connec- Click the test button to perform a USB communications test.

tions

Options Confirm serial ID when If you select this option, the names and serial IDs are

going online. compared between the project and the HMI when you

go online to make sure that a connection is made to the
intended HMI.

Communications You can set the response monitoring time for communications with the HMI.

time-out An error is displayed if a response is not received before this time expires.

*1. The time can be set to between 1 and 3,600 s.

6-2-3 Online Connection

Use the following procedure to place the Sysmac Studio online with the HMI.

1 Select Online from the HMI Menu. Or, click the Go Online Button () in the Toolbar.

The following message is displayed the first time you go online. After you write the project
name, this message is not displayed.

INH ue ypm auluo Buies z-9

Warning

The HMI device has no name.
Do you want to write the project name[HMIL_NA5_0] to the HMI device name? (Y/IN)

Yes No

@ Additional Information

The same message will be displayed the next time you connect if the HMI device name that is
set in the project is different from the HMI device name that is set in the HMI.

UoIPBUUO) BUIUD £-Z-9
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6 Connecting to the HMI

2 Click the Yes Button.

The Sysmac Studio goes online and the color of the bar under the Toolbar changes to yellow.

6-2-4 Going Online after Checking the Connection Method

Use the following procedure to go online if you selected the option to select the connection method
whenever you connect the computer with the HMI in the Communications Setup Dialog Box.

1 Select Online from the HMI Menu. Or, click the Go Online Button () in the Toolbar.
The Communications Setup Dialog Box is displayed.

The IP address that is set in the Communications Setup Dialog Box is displayed below the
Ethernet connection via a hub Option.

2 Select the connection method and then click the OK Button.
The Sysmac Studio goes online.

6-2-5 Going Offline

Use the following procedure to go offline.

Select Offline from the HMI Menu. Or, click the Go Offline Button ( i ) in the Toolbar.
The Sysmac Studio goes offline.
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6-2-6 Confirming Serial IDs

The serial ID is verified when going online if the option to do so was selected in the Communications
Setup Dialog Box. If the serial ID of the project on the Sysmac Studio is different from that of the HMI,
the following confirmation dialog box is displayed when you attempt to go online.

1 Click the Yes Button.

The serial ID of the project on the Sysmac Studio is rewritten to the same value as that of the
HMIL.

INH ue ypm auluo Buies z-9

El Precautions for Correct Use

+ If a USB connection is used, an Ethernet IP address of 192.168.255.xxx is used internally.
When using a USB connection, do not use an IP address of 192.168.255.xxx for the Ethernet
interface card in the computer.

» Socket ports 9600 and 2224 are used for Ethernet UDP/IP communications. When using
Ethernet UDP/IP communications, do not use these ports for any other application.

* When using a direct Ethernet connection and there is more than one Ethernet interface card
mounted in the computer, you must select the Ethernet interface card to use. Refer to the
Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for specific selection proce-
dures.
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Debugging
I

This section describes offline debugging using the HMI Simulator.

7-1 HMI Debugging Functions . . ............. . i 7-2
7-1-1 Watch TabPage . ... . e 7-2
7-1-2  Breakpoints . ... ... 7-3
7-1-3  Step Execution . ........ ... e 7-4
7-1-4  Offline Debugging with Only the HMI Simulator . ....................... 7-6
7-1-5  Offline Debugging with the Controller Simulator .. ...................... 7-7
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7 Debugging

7-1 HMI Debugging Functions

The operations you can use for debugging on the Sysmac Studio are listed below. The HMI Simulator is
used for offline debugging. You can use the HMI Simulator by itself, or you can connect it to the Control-
ler Simulator to debug the entire system.

Although the Simulator simulates the operation of the HMI, there are differences from the
HMI in operation and timing. After you debug operation with the Simulator, always check
operation on the actual Controller and HMI before you use them in the actual system. Acci-
dents may occur if the controlled system performs unexpected operation. Refer to A-3 Dif-
ferences between the Physical HMI and Simulator on page A-7 for details on differences in
operation.

Although offline debugging simulates the integrated operation of the HMI and Controller,
there are differences in operation and timing in comparison with combining the actual HMI
and Controller. After you debug operation with the simulation, always check operation on
the actual Controller and HMI before you use them in the actual system. Accidents may 0
occur if the controlled system performs unexpected operation. Refer to A-3 Differences
between the Physical HMI and Simulator on page A-7 for details on differences in opera-
tion.

The following three functions are provided for debugging during HMI simulations. These functions are
the same regardless of whether they are used in offline debugging.

» Watch Tab Page
» Breakpoints
» Step execution

7-1-1  Watch Tab Page

The basic Sysmac Studio operations of the Watch Tab Page apply to HMIs.
Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for details.

However, the following differences exist for HMI projects.
* You can monitor the following variables on the Watch (Project) Tab Page.

Standard projects:  Only global variables can be registered. You can continuously monitor any of
the global variables. Register the variable names as they are.
IAG projects: You cannot monitor variables in the IAG project.

» The Watch Tab Page functions only for the Simulator. Even if you are online with the physical HMI,
you cannot monitor the variables in the physical HMI.
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7-1-2 Breakpoints

You can set breakpoints in the source code of a subroutine. You can use breakpoints to pause the exe-
cution of a subroutine at any desired point.

I Setting and Clearing Breakpoints

@ Setting Breakpoints

You can set breakpoints to pause execution of a simulation, e.g., to see the status after a subroutine
is executed.

® Procedure

To set a breakpoint, move the cursor to the line in the subroutine where you want to set the break-
point and select Set/Clear Breakpoint from the Simulation Menu.

If you repeat this operation, the breakpoint will be cleared.

suopoung buibbngaq INH L-2
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I Clearing All Breakpoints

You can clear all of the breakpoints at the same time.

Select Clear All Breakpoints from the Simulation Menu to clear all of the breakpoints.
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7-1-3 Step Execution

You can use step execution when subroutine execution is paused at a breakpoint to trace operation one
line of the source code at a time.

I Step Execution

You can use step execution to execute the source code of a subroutine one line at a time.

If you select Step In and other commands from the Simulation Menu while paused at a breakpoint dur-
ing a simulation, you can control execution one line or one function at a time.

I Step Execution

The Step Execution command executes one function at a time.

Select Step Execution from the Simulation Menu when subroutine execution is paused during step-in
execution.

I Step-in Execution

Step-in execution performs step execution for the source code of a subroutine.

When you execute a program through the Simulator, select Simulation - Step In when the subroutine
is stopped at a breakpoint, paused, or stopped during step execution.
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I Step-out Execution

Use the Step Out command to exit a subroutine during step-in execution.

Select Step Out from the Simulation Menu during step-in execution.

I Continue

The Continue command executes the subroutine to the next breakpoint.

Select Continue from the Simulation Menu when subroutine execution is paused during step-in execu-
tion.

suopoung buibbngaq INH L-2

N

uonnoex3 deig ¢-1-/

NA-series Programmable Terminal Software User’s Manual (V118) 7-5



7 Debugging

7-1-4  Offline Debugging with Only the HMI Simulator

Before you check the entire system, you can perform debugging with the HMI Simulator alone.

When you create a project and want to debug it, always check operation with only the HMI Simulator
first. The Sysmac Studio comes with a Simulator that simulates HMI functions.

I Procedure

Use the following procedure to start the Sysmac Studio and perform debugging.
Start the Sysmac Studio and create a project.

Create the HMI application.

Select Build HMI from the Project Menu to build the project.

A WN =

Select Start NA Simulation from the Simulation Menu.

The Simulator starts.

@ Additional Information

If the project is not yet built, it is built automatically.
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5 To stop the simulation, click Stop NA Simulation from the Simulation Menu. The HMI Simulator
is ended.

7-1-5 Offline Debugging with the Controller Simulator

You can perform debugging with the HMI Simulator connected online to the Controller Simulator. This
allows you to debug the project while the Controller program is actually running.

After you complete checking operation with the HMI Simulator alone, check operation that includes the
Controller program. The Sysmac Studio enables integrated debugging of the Controller program and
the HMI application by connecting the Controller Simulator to the HMI Simulator.

You can perform debugging with the HMI Simulator and Controller Simulator connected when either the
HMI or the Controller is selected, but the restrictions depend on which is selected, as described below.
You cannot change a device while debugging is in progress.
+ Starting When the HMI Is Selected
You cannot use the debugging functions and Simulator control functions of the Controller. The only
Controller debugging function you can use is monitoring in the Watch Tab Page.
+ Starting When the Controller Is Selected
You cannot use the debugging functions of the HMI. The only HMI debugging function you can use is
monitoring in the Watch Tab Page.
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I Procedure

Use the following procedure to start the Sysmac Studio and perform debugging.
Start the Sysmac Studio and create a project.

Create the Controller program.

Create the HMI application.

Select Build HMI from the Project Menu to build the project.

A WN =

Select Run with Controller Simulator from the Simulation Menu.

@ Additional Information

If there is more than one Controller in the project, the window will be displayed for the Controller
that is currently connected. If you select a Controller for which variables are not mapped, an
error will occur and starting the Simulator will be canceled.

The Controller Simulator is started and the HMI Simulator is displayed.

@ Additional Information

If the project is not yet built, the entire project including the Controller is built automatically. If a
building error occurs for the Controller, a dialog box is displayed to notify you of the error.
Change the device to the relevant Controller, build the project, and check the error.
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6 To stop the simulation, click Stop NA Simulation from the Simulation Menu. The Controller
Simulator and the HMI Simulator are stopped.

% Additional Information

You can also start online debugging when the Controller is selected in the project. Refer to the
Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for details.
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Synchronizing Projects
I

This section describes how to synchronize the projects between the HMI and the Sys-
mac Studio.

8-1 Synchronizing Projects .............. it iiiiineenens 8-2
8-2 Downloading . ...ttt e e e 8-5
8-2-1 Downloading While Online .. ... ... ... ... . . .. . . . . . .. 8-5
8-2-2  Using Storage Media for Downloading ............. ... ... .. ... .. ... 8-6
8-3 Uploading ...t i i ittt 8-9
8-3-1 Uploading Projects Online . ........ ... . i 8-9
8-3-2 Uploading with Storage Media ............ ... .. ... ... . . . .. . . ..., 8-11
8-3-3 Relinking Internal Devices ........ ... ... i 8-15
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8 Synchronizing Projects

8-1 Synchronizing Projects

Synchronization is used to transfer the project from the Sysmac Studio to the HMI.

The basic Sysmac Studio operations for synchronization generally apply to HMIs. Refer to the Sysmac
Studio Version 1 Operation Manual (Cat. No. W504) for details.

This section describes differences in synchronization when an HMI is selected.

/A WARNING

Sufficiently check the operation of any project that you create before you start actual system 0
operation.

Precautions for Safe Use

Unexpected operation may result if you set inappropriate network configuration settings. Even
if appropriate network configuration settings are set, confirm that the controlled system will not
be adversely affected before you transfer the data.

|E| Precautions for Correct Use

Do not perform any other operations on the Sysmac Studio while the Synchronization Window
is active. An error will occur and synchronization will fail.
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I Functional Differences When an HMI Is Selected

The following differences exist in synchronization when an HMI is selected.

* Detailed comparison is not supported.

+ Algorithm checking is not supported. Therefore, there is no way to prevent mismatches in build dates
that result from rebuilding.

« If the project version specified in the project is different from the version of the project in the HMI, the
runtime files will always be transferred.

» The following synchronization options are provided.

. When trans- ..
Option Default fer is enabled Description

Transfer source code to the Selected. Values written | Select this check box to transfer the source

NA device. to HMI code.

Relink internal devices in the | Selected. Values written | If this check box is selected, global variables

project (valid for Transfer from HMI are automatically mapped to the Controller

From Device) that is registered in the project when the
project is uploaded.

Clear the present values of Selected. Values written | If this check box is selected, the present val-

variables with Retain attribute. to HMI ues of Retain variables are cleared after the
data is downloaded.

Clear alarm log data from Selected. Values written | If this check box is selected, the alarm log in

memory to HMI non-volatile memory is cleared. If you have
changed the user alarm settings, you cannot
clear the selection of this check box.

Clear Data log data from Selected. Values written | If this check box is selected, the data log

memory to HMI data in non-volatile memory is cleared. If you
have changed the data logging settings, you
cannot clear the selection of this check box.

» The following dialog box is displayed when you connect to the HMI if the version of the system pro-
gram in the HMI is older than the version of the system program in the Sysmac Studio. You must
update the system program before you can perform synchronization. Update the system program
according to the displayed instructions.

Operating System Version Mismatch
Project Operating System Version = 1.1.0
Device Operating System Version = 1.0.0

The versions are incompatible.

Would you like to update the device to match the project?

M Precautions for Correct Use

* Projects that are downloaded with Sysmac Studio version 1.10 cannot be uploaded.

» Projects that are downloaded when the Transfer source code to the NA device Check Box is
not selected cannot be uploaded.
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8 Synchronizing Projects

I Differences in Comparison Results

The following differences apply to the comparison results.

® Verification Results Example

The verification results are displayed as shown in the following example.

Column

Item

Source

Project name on the Sysmac Studio

Source Modified Date

The last time that the project was built on the Sysmac Studio

Target Modified Date

The last time that the HMI project was built on the Sysmac Studio

Target

HMI project name

Detailed Comparison

This column is not used when an HMI is selected.

® Verification Units

The units for comparison that are shown in the Synchronization Window are listed in the following

table.
Synchronization data name | Level Qty Deta|lfed Remarks
comparison
HMI name 1 1 None
Project 2 1 None
Pages 3 1 None
Page* 4 N None
Subroutines 3 1 None
SubroutineGroup* 4 N None
Variables 3 1 None
Global Events 3 1 None
Alarms 3 1 None
Data Groups 3 1 None
Data logging 3 1 None
Recipe Template 3 1 None
Project Security 3 1 None
Troubleshooter 3 1 None
Languages 3 1 None
* 4 N None
Settings 3 1 None
HMI Settings 4 1 None
User Data 3 1 None
User Accounts 4 1 None
Recipe Instances 4 N None
Resource Files 3 1 None
Documents 4 1 None
*x 5 N None
Images 4 1 None
*x 5 N None
Videos 4 1 None
*x 5 N None
Runtime Files 3 1 None
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8-2 Downloading

To execute a project that you created in the HMI, you must use synchronization to download the proj-
ect. This section describes how to download the project.

8-2-1 Downloading While Online
You can use the following procedure to download the project while the Sysmac Studio is online.

1 Place the Sysmac Studio online with the HMI. Refer to Section 6 Connecting to the HMI for
details.

2 Click on the Toolbar. Or, select Synchronization — NA Device from the HMI Menu.

3 The project on the Sysmac Studio is compared with the project in the HMI and the Synchroniza-
tion Window is displayed.
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4 Select the items to download and select the options as required.

Click the Transfer to Device Button. The data is downloaded and the HMI is restarted. NS
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8-2-2 Using Storage Media for Downloading

With an HMI, you can perform product downloads with storage media.
1 Insert an SD Memory Card or USB memory device to use for the download into the computer.

2 Select Media Device — Synchronization from the HMI Menu.

3 Select the file to use for the download and click the OK Button.
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8 Synchronizing Projects

4 The project on the Sysmac Studio is compared with the project in the storage media and the
Synchronization Window is displayed.

5 Click the Transfer to Device Button to transfer the project to the storage media.

6 Insert the storage media into the HMI, display the Device System Menu, and touch the Transfer
Operations Button.

Buipeojumoq z-8
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8 Synchronizing Projects

7 Touch the Transfer User Program to HMI Button.

Transfer Operations

Transfer User Transfer User Transfer Data To  Transfer Data From
Program To HMI ~ Program From HMI HMI HMI

8 Select the project to transfer and touch the Transfer to HMI Button to download the selected
project to the HMI.
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8 Synchronizing Projects

8-3 Uploading

To edit the project in an HMI on the Sysmac Studio, you must use synchronization to upload the project.
This section describes how to upload the project.

8-3-1 Uploading Projects Online
You can use the following procedure to upload a project while the Sysmac Studio is online.

1 Place the Sysmac Studio online with the HMI. Refer to Section 6 Connecting to the HMI for
details.

2 Click the (Synchronize) Button on the Toolbar. Or, select Synchronization — NA Device
from the HMI Menu.

3 The project on the Sysmac Studio is compared with the project in the HMI and the Synchroniza-
tion Window is displayed.

Buipeojdn ¢-8

4 Select the items to upload and select the options as required.
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8 Synchronizing Projects

Ll7] Precautions for Correct Use

When a project is uploaded, the internal devices are not linked. In this condition, you will not be
able to perform offline debugging with the Controller Simulator, or variable mapping.

Refer to 8-3-3 Relinking Internal Devices on page 8-15 for information on how to relink internal
devices.

5 Click the Transfer To PC Button. The following confirmation message for overwriting is dis-
played. Click the Yes Button.

Sysmac Studio

The project will be overwritten. Do you want to continue?

The project is uploaded and the changes are applied to the open project.

NA-series Programmable Terminal Software User’s Manual (V118)



8 Synchronizing Projects

8-3-2 Uploading with Storage Media
With an HMI, you can perform project synchronization with storage media.
1 Insert the SD Memory Card or USB memory device to use for the upload into the computer.

2 Display the Device System Menu and touch the Transfer Operations Button.

3 Touch the Transfer User Program from HMI Button.
Transfer Operations

Buipeojdn ¢-8
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Transfer User Transfer User Transfer Data To  Transfer Data From
Program To HMI  Program From HMI HMI HMI
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8 Synchronizing Projects

4 Specify the destination media and file name and touch the Transfer from HMI Button. The proj-
ect is uploaded to the specified media.

5 Insert an SD Memory Card or USB memory device into the computer and select Synchroniza-
tion - Media Device from the HMI Menu.

6 Specify the file name on the media specified for the upload and click the OK Button.

8-12 NA-series Programmable Terminal Software User’s Manual (V118)



8 Synchronizing Projects

7 The project on the Sysmac Studio is compared with the project in the storage media and the
Synchronization Window is displayed.

EI Precautions for Correct Use

When a project is uploaded, the internal devices are not linked. In this condition, you will not be
able to perform offline debugging with the Controller Simulator or variable mapping.

Refer to 8-3-3 Relinking Internal Devices on page 8-15 for information on how to relink internal
devices

Buipeojdn ¢-8
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8 Synchronizing Projects

8 Click the Transfer From Media Button. The following confirmation message for overwriting is
displayed. Click the Yes Button.

Sysmac Studio

The project will be overwritten. Do you want to continue?

The project is uploaded and the changes are applied to the open project.
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8-3-3 Relinking Internal Devices

When a project is uploaded, the internal devices will not be linked and there will be restrictions on oper-
ations related to the Controller, such as variable mapping. This section describes how to relink a Con-
troller in the project.

] Relinking while Uploading

If you select the Relinking to Internal Devices Check Box and upload the project, the internal devices in
the project that was uploaded are automatically relinked to the Controller of the same name. If there is
no Controller of the same name in the project, the Controller is registered as an unlinked Controller.

During relinking, the variables that are registered in the Controller in the project are compared with the
variables that are not registered in the Controller in the project. If no errors are detected, relinking is
completed.

I Relinking after Uploading

If you do not select the Relinking to Internal Devices Check Box and upload the project, the internal
devices in the project that was uploaded will not be linked to the Controller’s project.

‘Multiview Explorer -

HMI_MAS_ O - II II
¥ Configurations and Setup

¥ @ Device References
¥ #l Intemnal Devices
™8 new_Controller_0 (Unlinked)
 new_Controller_D
Use the following procedure to link the unlinked Controller with the Controller in the project.

Buipeojdn ¢-8

1 Place the Sysmac Studio offline from the HMI. Refer to Section 6 Connecting to the HMI for
details.
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8 Synchronizing Projects

2 Open Device References under Configurations and Setup in the Multiview Explorer and dou-
ble-click the unlinked Controller.

3 Select the Controller to link in the Internal Devices Area and click the Link to Internal Device
Button.

4 The variables that are registered to the specified Controller are compared with the variables that
are registered to the unlinked Controller. If no errors are detected, relinking is completed.
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@ Additional Information

8 Synchronizing Projects

If any variables that are registered to the destination Controller do not agree with the variables
that are registered to the unlinked Controller when relinking is executed, the following dialog

box is displayed.

Modify the global variables in the Controller and in the HMI according to the information pro-

vided in the dialog box.

() (b

(@)

Letter Item Description Remarks
(a) Conflict list Lists all of the conflicts.
(b) Cancel Cancels relinking.
(c) Continue Leaves the conflicts and completes relinking.
NA-series Programmable Terminal Software User’s Manual (V118) 8 -17
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Reusing Objects

This section describes how to reuse objects.

9-1 ReusingObjects .......... ..ottt ittt enaneeanens 9-2
02 LAGS ... et 9-3
9-2-1  Differences when an IAG ProjectIs Selected ... ....................... 9-3
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9-2-3  USING IAGS . ..ot 9-11
9-3 CustomObjects .......... ...t i e 9-14
9-3-1  Objects That You Can Register as Custom Objects . ................... 9-14
9-3-2 Creating Custom Objects .......... ... ... .. . .. 9-14
9-3-3 Deleting Custom Objects ........ ... ... .. . i 9-17
9-3-4 Using Custom Objects . ....... ... ... i 9-18
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9 Reusing Objects

9-1 Reusing Objects

The Sysmac Studio provides the following two functions to simplify and increase the speed of the devel-
opment of HMI applications.

* Intelligent application gadgets (IAGs)
+ Custom objects

IAGs and custom objects are different in the following ways.
* You can distribute IAGs to other parties. You can use custom objects only on the Sysmac Studio.

* You must treat IAGs as IAGs even after you place them on pages. You treat custom objects like any
other objects after you place them on pages.

» After you place an IAG on a page, you can change only the properties of the IAG objects. You can
change any of the attributes of custom objects.

* You can hide the contents of subroutines in IAGs. Therefore, you can provide IAGs to other parties
without disclosing technology.

You can customize objects yourself and create reusable objects that combine other objects.
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9 Reusing Objects

9-2 IAGs

An IAG is a library object that you can distribute to other parties. To create a new IAG, you must create
it in an IAG project. This section describes the procedures to create and use IAGs.

9-2-1 Differences when an IAG Project Is Selected

Even when an IAG project is selected, basic operations are generally the same as for a standard proj-
ect. However, the following items are different.

I Items in the Multiview Explorer

The structure of the Multiview Explorer when you select an IAG project is shown below. You can edit the
user-defined variables, subroutines, and other resources in an IAG from the menu that is displayed
when you right-click the IAG.

SOVI 2-6

Configurations and Setup HMI
Language Settings IAGs
IAG Collection Settings Data
Resources

pa108]9g S| 198l01d OV Ue usym seoualalld L-2-6
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9 Reusing Objects

I Toolbar

This section describes the differences in the Toolbar compared with a standard project.

® Insert Menu

Item Description Remarks
IAG Inserts a new IAG in IAGs.

® Project Menu

Item Description Remarks
Build IAGs Builds all of the IAGs.
Publish IAG Collection | Saves an IAG collection in a file format that you can use in a standard project.

I Language Settings

You can set the languages to use in the IAG.

— (a)

— (b)
(€)

() (d)

Symbol Item Description Remarks
(a) Default language Sets the language that is selected by default.
(b) Defined Languages Displays the languages that you select.
©) S This button moves a selected language to the defined
language list.
(d) < This button deletes a selected language from the
defined language list.
(e) Available Languages Displays the languages that you can select.
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9 Reusing Objects

I IAG Collection Settings

You can make the following settings for an IAG collection.

(@)
(b)

(c)

(d)
(e)

Symbol Item Description Remarks
(a) Name Sets the name.
(b) Version Sets the version.
(c) Description Sets a description.
(d) Publisher Sets the publisher.
Select this check box to display the IAG collection
(e) Visible By Default | in the Toolbox when the IAG collection is imported
into the Sysmac Studio.

] 1acs

The following tab page is used to create an IAG. The procedures are generally the same as for standard
projects, except for the following differences.

» There are no global variables. Only the user variables for each IAG can be used.

* You cannot set page animations.

* You cannot use functions that cannot be placed on a page, such as global events and recipes.
* You cannot use Trend Graph or Broken-line Graph objects and user-created IAGs.

SOVI 2-6

pa108]9g S| 198l01d OV Ue usym seoualalld L-2-6
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9 Reusing Objects

I User Variables

For IAG, only the variables for each IAG can be used. The variables that are defined for each IAG are

called user variables.
You can create user variables that are internal variables and user variables that are In/Out variables.

® Editing User Variables
To edit user variables, right-click IAG and select View User Variables from the menu.

® Internal Variables

The internal variables are used only within the IAG. The internal variables are displayed in the user
variable table, but you cannot access them when you use the IAG.

(@) (b) () (d) (e)

v I R
I — i -
|

In/Out blrInternalSample Boolean

intlnternalSample Integer

Letter Item Description Remarks
a Internals or In/Out Changes the display between internal variables
and In/Out variables.
b Name Sets the variable name.
c Data Type Sets the data type.
d Initial Value Sets the initial value.
e Comment Sets a comment.
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9 Reusing Objects

® In/Out Variables
In/Out variables are exposed externally. You can access the In/Out variables when you use the IAG.

(@) (b) (c) (d) (e) )

1AG0 User varooe: < 1 I I R I |
[ Reme ] Detatyoe ] wowr | osaivae /<o

blnInSample Boolean [nput

intlnoutSample Integer [n/Cut

Letter Item Description Remarks
a Internals or In/Out Changes the display between internal variables
and In/Out variables.
Name Sets the variable name.
Data Type Sets the data type.
d In/Out If you set an In/Out variable, you can read and

write the variable when you use the IAG.

If you set an input variable, you can only write
the variable when you use the IAG.

e Initial Value Sets the initial value.

f Comment Sets a comment.

I Data Types

You can set the data types to use in the IAG. The procedures are the same as for a standard project.

root

Structures
w | RGB STRUCT ©
Red Boolean N
Green Boolean ;
Blue Boolean g’

I Resources

You can set the resources to use in the IAG. The procedures are the same as for a standard project.

pajos|es s| 198loid DY| Ue usym ssousteayld L-Z-6
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9 Reusing Objects

9-2-2 Creating an IAG

This section describes how to create an IAG.

The size of the IAG will be the size of the page when the IAG is created. Any objects that are positioned
outside of the page are ignored.

1 Create a new project and set the project type to IAG Project.

| Select IAG Project. |

2 Click the Create Button.
An IAG project is created and the following window is displayed.

3 Right-click the IAG, select View User Variables from the menu, and then register the required
user variables.
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9 Reusing Objects

4 Create the IAG with the same methods as for a normal page.

5 Select Build IAGs from the Project Menu.

6 Select Publish IAG Collection from the Project Menu.

7 Click the Browse Button (...) and specify where to save the collection.

Publish IAG Collection
publishing To |

SOVI 2-6

Build IAG Project  Not Started
Publish IAGD Mot Started
PublishIAG File  Not Started

ov| ue buneasd z-z-6
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9 Reusing Objects

8 Click the Publish Button. The IAG collection is created.
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9 Reusing Objects

9-2-3 Using IAGs

This section describes how to use the IAGs that you create when you edit a standard project.

To use IAGs, you must first register them in the Toolbox. After you register them in the Toolbox, you can
drag them to the page to use them in the same way as for other objects.

I Registering IAGs

1 Select IAG Collections Manager from the Project Menu.
"B 1AG Collections Manager =)

+

2 Click the + Button. Select the IAG file and click the Open Button.

SOVI 2-6

soy| buisn ¢-2-6
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9 Reusing Objects

3 Select the Show in Toolbox Check Boxes for the IAG collections that you want to display in the
Toolbox.

4 The IAGs for the selected check boxes are displayed in the Toolbox.

9-12 NA-series Programmable Terminal Software User’s Manual (V118)



9 Reusing Objects

5 Drag the IAG to the page.

6 Double-click the IAG and set the properties.
Set global variables or constants for the variables that are set as In/Out variables.

SOVI 2-6
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9 Reusing Objects

9-3 Custom Objects

You can register the objects that you use most frequently to increase your productivity. This section
describes the procedures to create and use custom objects.

9-3-1 Objects That You Can Register as Custom Objects

An object must meet the following conditions before you can register it as a custom object.

* You can register only individual objects.

You cannot register more than one object as a custom object. If you want to register more than one
object as a custom object, group the objects into one object first.

* The object cannot be a user-defined IAG.

You cannot register a user-defined IAG or a group that contains a user-defined IAG as a custom
object.

9-3-2 Creating Custom Objects

Use the following procedure to create a custom object.

1 Create a standard project and place the objects to register as a custom object on the page.

9-14 NA-series Programmable Terminal Software User’s Manual (V118)



9 Reusing Objects

2 Group the objects to register the group as a custom object.

3 Right-click the group of objects and select Add to Toolbox from the menu.

sjoa[qo woisny ¢-6

s108[qO wojsng bunesiy z-¢-6
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9 Reusing Objects

4 The group is added as a custom object under Custom in the Toolbox. The displayed name is
the name of the registered group or object.

9-16 NA-series Programmable Terminal Software User’s Manual (V118)



9-3-3 Deleting Custom Objects

Use the following procedure to delete a registered custom object.

9 Reusing Objects

1 Right-click the custom object to delete from the Toolbox. Select Delete from the menu.

2 A confirmation dialog box is displayed. Click the Yes Button.

Celete Iterm

Are you sure you wish to delete the item? Groupl

NA-series Programmable Terminal Software User’s Manual (V118)
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9 Reusing Objects

9-3-4 Using Custom Objects

Itis very easy to use a custom object. Just select the desired custom object in the Toolbox and drag it to
the page. You can handle the custom objects on pages in the same ways as you handle normal objects.
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10

Connecting to HMIs from External

Devices
]

This section describes how to connect to an HMI from an external device.

10-1 Accessing an HMI from an External Device ....................... 10-2
10-1-1 VNC L 10-2
10-1-2 FTP L 10-3
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10 Connecting to HMIs from External Devices

10-1 Accessing an HMI from an External
Device

You can use the following two methods to access an NA-series Programmable Terminal from an exter-
nal device.

* Remote monitoring and control with VNC
 File operations with FTP

|E| Precautions for Correct Use

+ Only password security is provided for using VNC and FTP. Sufficiently consider the network
configuration in terms of security and implement any required measures to prevent unauthor-
ized access.

» Use the same keyboard layout settings for the VNC client computer and the HMI. If the set-
tings are not the same, different characters may results from the characters input from the
VNC client.

10-1-1 VNC

You can enable VNC to use a VNC client to monitor and control HMI pages. You can also use a mode
setting to prohibit controlling operation from a VNC client and allow only monitoring.

I Setting Method

Double-click HMI Settings under Configurations and Setup. Click the VNC Settings Button.

Select the Use Option for Enable VNC and change the setting of the Mode Box as required. Set a text
string in the Password Box.
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10 Connecting to HMIs from External Devices

After you complete the settings, select Build HMI from the Project Menu. When building the project is
completed, download the project to the HMI.

After the download is completed, you can access the HMI from a VNC client.

@ Additional Information

Refer to the relevant software manuals for the operating procedures of the VNC client.

ue wouy [INH ue Buissesdy |-0L

991A9( [eulaIxg

10-1-2 FTP

You can enable the FTP server to use an FTP client to access files in the HMI. However, you can
access only specific folder.

dld ¢-l-0l

I Setting Method

Double-click HMI Settings under Configurations and Setup. Click the FTP Settings Button.

Select the Use Option. Set text strings for the login name and password.

After you complete the settings, select Build HMI from the Project Menu. When building the project is
completed, download the project to the HMI.

After the download is completed, you can access the HMI from an FTP client.

@ Additional Information

Refer to the relevant software manuals for the operating procedures of the FTP client.
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Other Functions
]

This section describes other functions that the Sysmac Studio provides for HMIs.

11-1 Sysmac Studio Option Settings ................ .. ... . iiiin.. 11-2
-2 Printing .......o i e e 11-4
11-2-1 Printable Items . ... ... 11-4
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11 Other Functions

11-1 Sysmac Studio Option Settings

The following Sysmac Studio option settings are related to HMIs.

+ HMI Code Editor
* HMI Page Editor

| HMI Code Editor

You can make settings to highlight text in the HMI Code Editor.

P

Option
p Color Theme
p Ladder Editor
P ST Editor
¥ HMI Code Editor

Color Selection  Global vanables
Keywords
Comments
Strings

Breakpoints

Foreground text

Background

» HMI Page Editor
» Program Check/Build
» Vanables

p Synchronization

. R:180 G:0 B:90

|

B Green

. Maroon

W Maroon

Collapsed text or region §  [El

. Black

» Comments for Variables and Data Types

[ [White

Reset to default settings——

Symbol Item Description Remarks
(a) Color Selections Select the color for each item.
(b) Reset to default settings This button resets the colors to the
default settings.

1-2
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11 Other Functions

] 1M Page Editor
You can make settings for the grid in the HMI Page Editor.
Option

» Color Theme

» Ladder Editor

» ST Editor

» HMI Code Editor
¥ HMI Page Editor

sBujes uondQ oipmig sewsAg -1

s Gnd Size (a)
Snap to Gnd

Show Grid
Thickness
Color
Style
Opacity

» Program Check/Build
» Vanables
p Comments for Vanables and Data Types

» Synchronization

oK
Symbol Item Description Remarks
(a) Grid Settings Make the settings for the grid.
(b) Reset to Defaults This button restores the default grid
settings.
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11-2 Printing

This section describes the printing feature.

11-2-1 Printable Items

1-4

The following items can be printed. You can select the items to print.

Category of project

Items Standard IAG

Device References

Variable Mapping

Pages

Page Subroutines

User Alarms
HMI Settings
Controller Events

Data Logging
Security Settings
Troubleshooter

Language Settings

Recipes

Data

Global Events
Global Subroutines

N AN ENENEN RN AN AN ENEN ENENEN ENENAN

Resources
IAG Collection Settings v
IAGs v

@ Additional Information

For printing features that are unique to devices other than the HMI, refer to the relevant manu-
als.

For details on the settings and the procedure for printing, refer to the Sysmac Studio Version 1
Operation Manual (Cat. No. W504).
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Appendices

The appendices provide information on supported file formats and other information.

A-1 Eventsand Actions .......................
A-2 Supported Formats .......................
A-3 Differences between the Physical HMI and Simulator
A-4 Version Upgrade History

A-5 Precautions for Version Upgrades
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Appendices

A-1 Events and Actions

|
I Events
Name Description Global Page | Objects User IAG
events alarms
Acknowledged The event occurs when the user alarm is . . . Yes .
acknowledged.
Checked The event occurs when the check box is . . Yes . .
selected.
Cleared The event occurs when the user alarm is . . i Yes i
cleared.
Click™ The event occurs when the object is tapped. — — Yes — —
Condition The event occurs when the set condition is Yes Yes . . Yes
met.
F1 Key Click™ The event occurs when the F1 Key is tapped. Yes Yes — — —
F1 Key Press The event occurs while the F1 Key is held Yes Yes . . .
down.
F1 Kev Rel *1 The event occurs when the F1 Key is Yes Yes . . .
ey helease released.
F2 Key Click™ The event occurs when the F2 Key is tapped. Yes Yes — — —
F2 Key Press The event occurs while the F2 Key is held Yes Yes . . .
down.
F9 Kev Rel - The event occurs when the F2 Key is Yes Yes . . .
ey Release released.
F3 Key Click™ The event occurs when the F3 Key is tapped. Yes Yes — — —
F3 Key Press The event occurs while the F3 Key is held Yes Yes . . .
down.
F3 Kev Rel *1 The event occurs when the F3 Key is Yes Yes . . .
ey helease released.
Interval The event occurs at the specified interval. Yes — — — —
Page Displayed The event occurs while the page is displayed. — Yes — — —
Page Hidden The event occurs when the page is hidden. — Yes — — —
The event occurs while the object is held
Press — — Yes — —
down.
) ...« | The event occurs when the project is initial-
Project Initialization . Yes — — — —
ized.
Raised The event occurs when the user alarm . . i Yes i
occurs.
Rel * The event occurs when the object is . . Yes . .
elease released.
Selection Changed The _event occurs when the item selected in . . Yes . .
the list changes.
Unchecked The _event occurs when the check box selec- . . Yes . .
tion is cleared.

*1. For both Click and Release, the event occurs when the object is released, but the operation when the page is
changed is different. If the page changes when an object set for Click is touched but not yet released, the event
does not occur. If the page changes when an object set for Release is touched but not yet released, the event
does occur.

*2. The results of accessing external variables during project initialization immediately after startup are not always
dependable. Do not access external variables during project initialization.
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I Actions
Action Description Global Page | Objects User IAG
events alarms
BuzzerOff Turns OFF the buzzer. Yes Yes Yes Yes Yes
BuzzerOn Turns ON the buzzer. Yes Yes Yes Yes Yes
. Turns ON the buzzer that beeps for
1
BuzzerOneShot only 0.25 second. Yes Yes Yes Yes Yes
Executes a subroutine registered
CallSubroutine as a global subroutine or page sub- | Yes™ Yes Yes Yes? Yes
routine.
ClearUserAlarmLog Clears the user alarm log. Yes Yes Yes Yes Yes
ClosePage Closes the specified page. Yes Yes Yes Yes Yes
DecreaseVariable Subtract.s.the spgmfned value from Yes Yes Yes Yes Yes
the specified variable.
EjectSDMemory E;?;Ies removing the SD Memory Yes Yes Yes Yes Yes
EnablelnputOperation Enables or disables inputs on the Yes Yes Yes Yes Yes
touch panel.
EndSyncLock 3 Ends a critical section. Yes — — —
IncreaseVariable Adds. Fhe Spe.CIerd value to the Yes Yes Yes Yes Yes
specified variable.
InvertVariable Inverts the V.a lue of the specified Yes Yes Yes Yes Yes
Boolean variable.
Login Displays the login page. Yes Yes Yes Yes Yes
Logout Logs out the user. Yes Yes Yes Yes Yes
ResetVariable Changes th? value of the specified Yes Yes Yes Yes Yes
Boolean variable to False.
SaveUserAlarmLog- )
ToFile Saves the user alarm log to a file. Yes Yes Yes Yes Yes
SetlnputFocus Sets the data input focus. - Yes Yes - Yes
h th ject | t-
SetLanguage tCi)n;snges © projectlanguage se Yes Yes Yes Yes Yes
SetVariable Sets the value_ Qf the specified vari- Yes Yes Yes Yes Yes
able to a specified value.
ShowAlarmPage Displays the page set in a specified Yes Yes Yes Yes N
User Alarm.
ShowDocu- Displays a PDF or other file full
ment(FULL SCREEN) | screen. ves Yes Yes Yes Yes
ShowDocument(Win- D!splays a PDF or other file in a Yes Yes Yes Yes Yes
dow) window.
ShowPage*“ Displays a page. Yes Yes Yes Yes Yes
., | Displays the most recently dis-

i 4 Y Y Y Y Yo
ShowPreviousPage played page. es es es es es
ShowSystemMenu Displays the System Menu. Yes Yes Yes Yes Yes
ShowTroubleshooter Displays the NJ/NX Trouble- Yes Yes Yes Yes -

shooter.
StartDatalLogging Starts data logging. Yes Yes Yes Yes Yes
StopDatalogging Stops data logging. Yes Yes Yes Yes Yes
SynclLock 3 Starts a critical section. Yes - - - -
NA-series Programmable Terminal Software User’s Manual (V118) A-3
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Global User

events Page | Objects IAG

Action Description
alarms

. Sets the UserEvents for IAG
TriggerEvent - -

objects. - - Yes

*1. When multiple actions attempt to simultaneously beep buzzers, the last buzzer demand overwrites the previ-
ous demands.

*2. You cannot execute page subroutines for global events or user alarms.
*3. The SyncLock and EndSynclLock actions must be specified as a pair.
*4. If you execute an action with a Momentary Button, use a Click or Release event.

@ Additional Information

If the same variable might be accessed simultaneously from different locations, such as for

simultaneous execution of subroutines, perform exclusive control to prevent simultaneous
access.

For a section where exclusive control is required, specify the start of the section with the Syn-
cLock action and the end of the section with the EndSyncLock action. This defines the section
between these two actions as a critical section. Until the execution of the critical section is com-
pleted, other processing will not be executed, therefore achieving exclusive control.
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A-2 Supported Formats

The HMI objects support the following formats. However, it may not be possible to display some files
even if the file format is supported.

»
N
I Image Files §
o
The following formats are supported. i
g
Format name Ex.ten- Specifications é
sion 7]
Microsoft Windows Bit- BMP 1, 4, 8, 16, 24, or 32-bit
map Image Uncompressed or RLE compression
Graphics Interchange GIF 1, 4, or 8-bit
Format Transparent GIF or interlaced GIF
JFIF or EXIF JPG 8-bit gray scale
24-bit/basic DCT or progressive DCT
Portable Network Graph- | PNG 1, 4, 8, or 24-bit
ics Transparency is supported.
Scalable Vector Graphics | SVG SVG 1.0 is supported.
Extensible Application XAML
Markup Language
Drawing Exchange For- DXF R12 and older are supported.
mat
] video

The following formats are supported. However, only progressive formats are supported. The maximum
size of the file that can be registered in a project in Sysmac Studio is 100 MB.

Exten- e Maximum
Format name . Specifications .
sion resolution
MPEG-1 mpg The MPEG-1 Video Stream format is not supported. 768x480
MPEG-2 mpg Main Profile Low, Main, and High 1440 1280x720
MPEG-2 TS is not supported.
MPEG-4 Part 2 mp4 Simple Profile LO, L1, L2, and L3 1280x720

Advanced Simple Profile LO, L1, L2, L3, L4, and L5
Global motion compensation is not supported.

MPEG-4 Part 10 mp4 | Baseline Profile L1, L1.2, L1.3, L2, L2.2, and L3 1280x720
(H.264) Main Profile L1, L1.2, L1.3, L2, L2.2, L3, L3.1, L3.2, and L4.1

High Profile L1, L1.2, L1.3, L2, L2.2, L3, L3.1, L3.2, and L4.1
Windows Media Video | wmv WMV9 240x%160
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I Files Supported by Document Viewer

The Document Viewer can display the following files. The maximum size of file that can be registered in
a project in Sysmac Studio is 16 MB.

Format name Ex.ten- Specifications
sion
Adobe Acrobat Document PDF
Microsoft Excel Books xlsx
Microsoft Excel 97-2003 Books xls
Microsoft Word Documents docx
Microsoft Word 97-2003 Docu- doc

ments
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A-3 Differences between the Physical HMI
and Simulator

The following differences exist between the physical HMI and Simulator.
» Trend Graph and Broken-line Graph Objects

The Simulator does not update graphic displays. Fixed still images are displayed.
» ShowDocument Action and ShowDocument Function

The Simulator ignores parameters that specify the display positions and sizes for documents. To dis-
play documents, there must be a compatible application, such as Adobe Reader. The application
used to display a document will not be exited when the Simulator is exited or the page is changed
after the document is displayed. Exit the application manually.

» ShowTroubleshooter Action and ShowTroubleshooter Function
The Simulator cannot display the NJ/NX Troubleshooter.

» _HMI_Brightness Variables
The brightness of the screen does not change for the Simulator.

Joje|nwig pue [NH [ed1sAyd 8y} usamiaq sasuasaplq €V
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A-4 Version Upgrade History

This section describes the additions and improvements that were made during version upgrades.

A-4-1 Version Upgrade History for Sysmac Studio and Runtime

Sysmac Studio Version 1.10 and Runtime Version 1.00

Item

Description

First release

Support added for NA-series Programmable Terminals.

Sysmac Studio Version 1.11 and Runtime Version 1.01.

Item

Description

Uploading

Added support for uploading.

Expansion of popup page func-
tionality

Expanded functionality for popup pages, such as the addition of display
position specifications.

Expansion of IAG functionality

Expanded functionality for IAG variables. Also added support for a Condition
event.

Expansion of settings for object
appearance

Expanded settings related to appearance, such as adding vertical text for
some objects.

Addition of data logging

Added Data Log and Trend Graph objects.

Sysmac Studio Version 1.13 and Runtime Version 1.02.

Item

Description

Support for NX7-series Control-
lers and NJ1-series Controllers

Added support for connection to NX7-series Controllers and NJ1-series
Controllers.

Addition of NJ/NX Troubleshooter

Added support for the NJ/NX Troubleshooter.

Addition of system variables for
VNC function

Added _HMI_ConnectedVNCClientCount system variable that represents
the number of clients that are connected to the HMI via VNC.

Sysmac Studio Version 1.14 and Runtime Version 1.03.

Item

Description

Addition of broken-line graph func-
tion

Added support for the broken-line graph function.

Expansion of NJ/NX-series trouble-
shooter functionality

Expanded functionality to display/delete event logs of the EtherCAT slave
units. Also added support that allows the troubleshooter to switch to a user
screen.

Support for union/enumeration vari-
ables

Enabled handling of union and enumeration variables of NJ/NX-series
Controllers, as well as inputting and displaying of them on HMIs.

Support for creating new structure
variables

Enabled creating new structure variables in the HMI.

Expanded maximum number of
variables registered in a connected
device

The number of global variables that can be registered in a connected
device was expanded to 30,000.

Expansion of IAG functionality

Enabled settings of user events for IAG.

HMI Main Unit screen capture func-
tionality

Enabled capturing screens displayed on the HMI.

Custom keypad functionality

Enabled creation of system keypads with user-specified sizes. Also added
support for editing then to make a user-specific colored/shaped keypad.
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Item

Description

Tabbing order functionality

Enabled settings of order in which to tab around the input focus during
data input

Scale conversion functionality for
numeric values

Enabled scale conversion of numeric values.

Indirect addressing of text strings

Enabled indirect addressing of text strings that are displayed on objects.

Buzzer function

Enabled sounding a buzzer from the HMI when a button is pressed, and
when an alarm occurs, or for other events.

Page jump from an alarm message
to a specified screen

Enabled a page jump from an alarm screen specified in the Alarm Viewer
to a specified screen.

Enhanced VNC functionality

Support for accesses control of VNC clients for various conditions.

Addition of tab control objects

Added tab control objects.

Support for background processing
of subroutines

Added support for background processing of subroutines to enable parallel
processing with updating of the display.

Version 1.11

Version Upgrade History for Sysmac Studio Only

Item

Description

Support for copying settings

Added support to copy settings for user alarm tables, data sets, and recipe
templates and paste them into external applications.

Improvement to property display
method

Enabled displaying properties by double-clicking objects.

Version 1.13

Item

Description

Support to copy CJ/NJ variable
settings

Added support to copy and paste variables directly from the Sysmac Studio
and CX-Programmer.

Version 1.14

Item

Description

Enhanced Search and Replace
functionality

Expanded target for the Search and Replace function to all the texts within
a project.

Support for the simulation mode

Enabled confirmation of indications such as the ON/OFF status of Lamps
and other objects.

Sysmac Studio printing functionality

Enabled printing of information including project settings with HMI
selected.

Direct text editing

Enabled direct editing of Labels on the Page Editor.

Importing of vector graphic files

Enabled selecting of vector graphic files (e.g.,.XAML files) for the Image
files of objects.

Improved Watch Tab Page

Enabled constant monitoring of global variables.

Cross reference function

Enabled cross reference when the HMI is selected.

NA-series Programmable Terminal Software User’
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A-4-3  Sysmac Studio Corresponding Versions

Sysmac Studio Runtime System program
1.10 1.00 1.1.0
1.11to0 1.12 1.01™1 2.0.0
1.13 1.0272 3.0.3
1.14 1.03°3 416

*1. The projects created in version 1.00 are converted to version 1.01.
*2. The projects created in either version 1.00 or 1.01 are converted to version 1.02.
*3. Projects created in version 1.00, 1.01, or 1.02 are converted to version 1.03.
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A-5 Precautions for Version Upgrades

|
Observe the following precautions for version upgrades.

® Sysmac Studio Version 1.14 and Runtime Version 1.03

» User-defined enumerations on external devices are not assigned during version upgrades. You
must redefine them.

+ Some data type definition names are reserved for the data definitions of structures, unions, and
numerations on the HMI. An error will occur if a reserved name is used, in which case you must
change the name.

sopeaBdn uoisiap 10j suonnessld G-y
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